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Basics

Discontinuation of “old“ HiCAD itemisation

As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be
available for model drawings that were aleady itemized with these functions. From HiCAD 2020 onwards,
only the “new” itemization will be supported.

Service Pack 2 2018 (V 2302)

Installation / Start of HiCAD

The ISD Update Service

The ISD Update Service supports the automatic search for and installation of HiCAD updates (Hotfixes). For this
you require the program ISDUpdateSvc.exe, that you can either activate during installation of HiCAD or install via
the Windows Control Panel afterwards. Via this program you can activate the ISD Update Service. Further inform-
ation can be found in the Automatic Installation chapter of the Installation Notes manual.

If the ISD Update Service is active, HiCAD checks upon its start whether a Hotfix is available. If this is the case, the
following message appears at the bottom right of your screen:

News Overview
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Itemisation

New part attribute: Item index %PIDX

Not only item numbers but also itemisation texts which consist of free text and attributes from different
HiCAD/HELiOS sources. The new HiCAD part attribute Item index %PIDX can be used in order to create own incre-
mentation in itemisation texts. If the itemisation text contains this attribute, each part with equal item number will
be incremented on its own. This means that all n parts with common itemisation number will be numbered con-
secutively with an index from 1 to n. In practice, this is often used to allocate assemblies or parts with equal item
number clearly to each information of the item number flag or BOM.

An example: 

The depicted Steel Engineering drawing consists of three assemblies, which in turn consist of equal hollow profiles.
The assemblies 1 and 2 are equal and consist of the parts 1b, 1c, 2b and 2c. Assembly 3 consists of four profiles,
part of which are equal to 3a and 3c as well as 3b and 3d.

The drawing should be itemised. In order to set i.a. the new attribute Item index itemisation texts should be created
automatically. For this, the function Drawing > Itemisation > Ite... > ... with Options will be used with the following
settings:

n Load the default settings for Steel Engineering via Favorites

n Tab General: Activate the checkbox Generate itemisation text

n Tab Part groups: Definition of the itemisation text for assemblies and Steel Engineering parts as follows:

Assemblies

Data source is the part itself.

Steel/Metal Engineering Parts

Data source is the part itself.

n Start itemisation.

14 / 268 What's new?

Basics



Result

1=Part type, (2) Item number, (3) Item index

If a copy of assembly 3 would be inserted into the drawing and then itemised again, the item index continued with
the next number (see example 3)

The itemisation text can also be issued via BOM.
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Example - Structure list

Please note:

When allocating the item index, it is not guaranteed whether already allocated indices still remain.

A simple example:

Let it be supposed that the original drawing contains three equal parts with position indices 1, 2 and 3. Now, the
part with item index 2 will be deleted. The parts with index 1 and 3 remain. If the drawing is itemised automatically,
two possible options can result:

n The part with former index 1 maintains it; the part with former index 3 retains index 2.

n The part with former index 1 retains index 2; the part with former index 3 retains index 1.
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Drawing Derivation

Structure Lists

As of HiCAD 2018, besides Quantity Lists also Structure Lists can be added in a Drawing Derivation. For this, the dia-
logue window Settings for view groups and the settings in the configuration management via Automatic drawing
derivation > Production drawing > Usage-dependent > NAME > View group (here, the NAME is the name of the
respective intended use) have been enhanced.

New / changed Dimensioning Rules for Sheet Metal

New dimensioning rules are available for sheet metal:

n 154 SHEET_DIAGONAL_CUT

applies dimension to diagonal sheet/plate cuts

Recommended settings Rule 154
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n 155 SHEETMETAL_FLANGE_INSECT / 156 SHEETMETAL_BENDINGANGLE_INSECT

Rule 155 applies dimension to the flange length of sheets in sectional views, Rule 156 to the bend angle of
sheets in sectional view. In case of flanges that are not parallel, the theoretical intersection point of the flanges
will be dimensioned.

Recommended settings Rule 155

Recommended settings Rule 156
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The recommended three settings for Rule 155 and 156 are simultaneously the new default
settings for the sectional views of sheets in the workshop drawing (intended use: DEFAULT 
(SHEET METAL).
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Sectional views of sheets

As of HiCAD 2018 SP2, the Section for generating sectional views always takes places at the shortest bend zone.
The sectional views are created with depth limitation and perpendicular to each bend zone.

In addition, the dialogue window Settings for sectional views of sheets has changed: 
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The following settings are possible:
Scale of sectional views

n Main parts / Subordinate parts
Here you select whether and how to name Main parts/Subordinate parts in sectional views. Possible
options: via this parameter you define if sections should be created either with or without angular dimensions.

l Do not annotate

l Annotate, default
The default templatefor Sheet metal will be used for annotation (PosNummer_Kantblech.ftd).

l Annotate, acc. to usage
Annotation takes place according to the usage-specific template for Sheet metal (POSNUMMER_
VERWART....DEFAULT(KANTBLECHE).FTD). If such template does not exist, the annotation will be applied
according to the default template.

n Boltings, Standard Parts, Weld seams
Via the checkboxes below you can determine whether boltings, standard parts and weld seams should be annot-
ated in sectional views or not.

The previous settings Angular dimensions in sections and Offset go-side are not available anymore. The rep-
resentation of Angular dimensions can be defined via the new dimensioning rule 156 and the Offset go-side via the
settings of the configuration management under Drawing > Representation > Sectional views with coating lines

Example of a workshop drawing of a coated sheet metal - with sectional view and representation
of coating
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Dimensioning 90° bend angle of sheet metal

As of SP2 it can be defined whether the dimensioning of 90° bend angle for sectional views of sheet metal can be
defined in drawing derivation. The ISD default settings are that all bend angle are to be dimensioned.

In order to deactivate the dimensioning of 90° bend angle, currently the system files

n STAB3DPAR.DAT (new customers) or

n STW_DIMSETTINGS.XML

must be adjusted manually.

STAB3DPAR.DAT

Here, the setting is done via

Display right angle for opening angle of bend zones of sheet metal? 1:yes, 0:no

0

STW_DIMSETTINGS.XML

Here, deactivating the dimensioning is done via line

</PARAM><PARAM Name="SHOWRIGHTANGLEOFBENDZONE" Typ="INT" Value="0">

If this line is not available it must be added manually.

Usage assignment for own part types

Usage assignments can now not only be defined for assembly and part types provided by the ISD, but also for freely
definable part types.

This means that you now have the option to define own part types you can, for instance, use own drawing derivation
configurations for Steel Engineering series beams that are based on 2-D cross-sections. For example, you could
define a part type called Series, and a corresponding usage assignment called Default(Series).

If you now create workshop drawings for model drawings with series beams and use the drawing parameters From
configuration, the configuration Default(Series) will be used for all series beams with the part type Series.

Changed dimensioning rules for railing segment

The automatic dimensioning for oblique railings has been improved. For this, dimensioning rules 1006 to 1009 for
the stair railing segment have been changed:

n Rule 1006: CLEARANCE_POST
If the clear distance between two posts is dimensioned as Individual dimension, the post thickness will not be
considered. The dimensioning takes places in all fields of the railing segments. If the dimensions of the rule are
not equal in all fields, only the dimension of the first field will be depicted.

Recommended setting for Rule 1006
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In dimension type Chain of dimensions the post thickness will be taken into consideration, too. If the chain of
dimensions of all fields is equal, only the chain of dimensions of the first field will be depicted.

n Rule 1007: CENTERDISTANCE_POST
The axis distance of two posts is dimensioned in all fields of the railing segment. If the dimensions of this rule
are equal in each field, only the dimension of the first field will be depicted.

Recommended setting for Rule 1007

n Regel 1008: CLEARANCE_WEBMEMBER
If the clear distance between two posts is dimensioned as Individual dimension, the post thickness will not be
considered. The dimensioning takes places in all fields of the railing segments. If the dimensions of the rule are
not equal in all fields, only the dimension of the first field will be depicted.

Recommended setting for Rule 1008

In dimension type Chain of dimensions the post thickness will be taken into consideration, too. If the chain of
dimensions of all fields is equal, only the chain of dimensions of the first field will be depicted.

n Rule 1009: CENTERDISTANCE_POS
This rule dimensions the axis distance between posts and vertical rods as chain of dimensions. The dimen-
sioning takes place in all fields of the railing segment. If the dimensions of the rule are not equal in all fields,
only the dimension of the first field will be created.

Recommended setting for Rule 1009
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Example 1:

The depiction shows a staircase with equal distance between post and following vertical rod as well as between the
vertical rods. The thickness of post and vertical rod are identical. The dimension and chain of dimensions of rules
1006-1009 are equal for each field.
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Example 2:

The oblique segment of the depicted staircase has individual distances for posts and vertical rods as well as dif-
ferent post and vertical rod thickness. Hence, dimension and chain of dimensions of rules 1006 to 1009 are not
equal.

Others

Selection of fonts

With regards to font size (e.g. for texts, measures, captions), HiCAD offers nominal size for fonts according to
DIN EN ISO 3098-0.
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Service Pack 1 2018 (V 2301)

Licensing
As of HiCAD 2018, the Metal Engineering functions Sealing, Foil and at Part with Material are also available in the
following modules and suites:

n HiCAD Beams+Profiles,

n HiCAD Metal Engineering,

n HiCAD Steel Engineering,

n HiCAD Steel Engineering - Stairs and Railings,

n HiCAD Steel Engineering suites,

n HiCAD Metal Engineering suites,

n HiCAD ALUCOBOND® suites.

Previously, the functions have been part of the Metal Engineering-Ribbon and could be found via 3D-Section. As
of HiCAD 2018, these functions are available via the docking window Civil Engineering functions under Civil Engin-
eering, general > Civil Engineering - Sectional views (3D).
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Performance - Reduced polyhedron model
When saving SZA and KRA files, the polyhedron model will be reduced as far as possible. This applies to referenced
parts and standard parts without processing in particular. By this, the file size and the time of saving and loading will
be decreased. When testing this, the drawing shown below has been taken into account with approx. 1700 parts.
About 900 parts of it were same parts - internally referenced. In HICAD 2018 SP1, the file size has been reduced
from 33 MB to 11 MB.

Manage favourites - Default settings
To several functions - for example Itemisation - settings predefined by ISD - ISD default settings and ISD factory

defaults- are available in the scope of delivery of HiCAD. These are locked for editing and marked with in Man-
age Favorites. In order to change and reuse these settings, they must be saved under a different name.

Itemisation - Context menu for favourites

With a lock symbol, marked favourites are locked by your system admin. They are also not deleteable or change-
able. If you have questions, please contact your system admin.

In case of an update, the existing default settings can be prescribed by ISD and/or further settings may
be added.
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Drawing derivation - Usage-dependent configurations
For Railings the following three new usage types are available in the Factory standards catalogue at Usage > Civil
Engineering > Steel Engineering > Railing:

n Skirting board profile,

n Handrail profile,

n Post profile.

You can assign usage-dependent configurations for drawing derivations to these new railing elements.

The following configurations have been preset for the new usage types in the Configuration Editor at Automatic
drawing derivation > Production drawing > Usage assignment:

Usage CONFIGKEY
Utilized

configuration
Consider for

drawing derivations

Post profile POSTPROFILE DEFAULT (STAHLROHRE) Yes

Handrail profile RAILINGPROFILE DEFAULT (HOHLPROFIL) Yes

Skirting board profile SKIRTINGPROFILE DEFAULT (FLACHSTAHL) Yes

Furthermore, the default setting for the vertical rods used for infills has been changed:

Usage CONFIGKEY
Utilized

configuration
Consider for

drawing derivations

Rod WEBMEMBER DEFAULT Yes

The default setting for Steel Engineering elements of the part type Round steel has also been changed:

Usage Part type
Utilized

configuration
Consider for

drawing derivations

All Round steel DEFAULT (STAHHLROHRE) Yes
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Drawing derivation - Dimensioning of sheet developments
The parameters for sheet development have been enhanced. In the dialogue Sheet development parameters, the
check box Processings is new.

By ticking this checkbox you determine that bores and subtractions will be dimensioned on blank sheets.

If you tick the Processings checkbox below Dimensioning, dimensionings will also be created for bores and sub-
tractions. The following must be considered: If the checkbox Separate chains of dimensions for bores and sub-
tractions is activated from the tab Bores/Boltings of the function Drawing > Itemisation/Detailing > Dim... >
Dimensioning Settings, separated chains of dimensions for bores and subtractions will be created.
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HELiCON-specific attributes
Due to the discontinuation of HELiCON, the HELiCON-related attributes shown in the table below are no longer
available after a new installation of HiCAD 2018 SP1. This change concerns the System attributes catalogue and
the settings in the Configuration Editor at System Settings > Referencing > Synchronization of attributes.

Attributes for HELiCON

%INSTANCE_ID HELiCON instance ID

%ISCHANGED HELiCON IsChanged flag

%ISSELECTED HELiCON IsSelected flag

%LAST_INSTANCE_ID Last HELiCON instance ID

$TN_COPY Copy of part name for HELiCON without HELiOS

CONFIGURATIONID HELiCON configuration ID

STATIC_PART HELiCON puchased part marking

TRANS_INFO HELiCON transfer info

After an update installation from an older version (before HiCAD 2018) the attributes will remain available.
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Intersection of tangents

A point option is available in 2D and 3D: Intersection of tangents

With this option you determine the intersection of two tangents. HiCAD will request you to identify two graphical ele-
ments you require. The tangent will be defined by the end point of the graphical element lying closer to the cursor
position. The new point is the intersection of both tangents.

In case if a graphical element is identified twice, for instance as arc, the intersection of tangents will be defined on
both end points of the graphical element.

(1), (2) - selected graphical elements (here planar sketch), (3) identified point
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Major Release 2018 (V 2300)

Changed licensing
n As of HiCAD 2018 the Steel/Metal Engineering module is no longer available. This module will be replaced with

the two modules HiCAD Steel Engineering and HiCAD Metal Engineering.

n In addition to the existing HiCAD Education Edition, a new HiCAD basic module, the Education Edition
Premium is now available. This module is exclusively indented for schools, i.e. only schools with an existing cus-
tomer number and license contact can have this module. The module contains all functionalities of the Edu-
cation Edition plus all interfaces and can be supplemented by HiCAD extension modules.

n From Version 2018 onwards, the HiCAD Steel Engineering module will contain the connections that you can
find in the Civil Engineering functions docking window at Civil Engineering, general.

n As of HiCAD 2018, the joints and connections of the Metal Engineering module can be found in the Civil Engin-
eering functions docking window at Metal Engineering / Facade Engineering and Civil Engineering, general.
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Itemisation - New procedure
HiCAD currently supports two different itemisation modes:

n Itemisation up to HiCAD 2017 and

n Standard itemisation as of HiCAD 2018 with new parameter settings.

One property of each drawing is the question whether it is to be itemized in the old or remastered mode. In the Con-
figuration Editor at System settings > Itemisation, revised > Itemisation mode you can specify the itemisation
mode to be used in new drawings. For model drawings without a fixed itemisation mode, the Itemisation up to
HiCAD 2017 mode will be used if they have at least been partly itemized.

In contrast to the Itemisation up to HiCAD 2017 mode, itemisation settings in the Standard itemisation as of
HiCAD 2018 mode will not be saved globally, but by model drawings. For a management of individual con-
figurations you can use the Manage favourites option that you already know from other functions. In the Con-
figuration Editor at System settings > Itemisation > Default settings you can choose a Favourite defining the pre-
settings for the Standard itemisation as of HiCAD 2018 mode. By default, settings for Mechanical Engineering,
Steel Engineering and Plant Engineering have been pre-defined. Which of these Favourites will be used depends on
the settings specified in the HiCAD Parameter configuration dialogue window.

The fixed part groups for the old Itemisation up to HiCAD 2017 are replaced by freely configurable part groups
when you use the new Standard itemisation. You can use a part filter to specify the elements belonging to a part
group.
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Furthermore, two options for number assignment are available:

n Rule-compliant (automatic / manual)
The item numbers for elements of the part group can be assigned automatically or manually and must comply
with the specified equality criteria.

n Unregulated (only manual)
The item numbers for elements of the part group can be assigned freely (except for conflicts with item numbers
according to rule-compliant number assignment). Automatic itemisation is not supported here.

Advantages of the new itemisation:

The current settings of the itemization parameters are saved in the model drawing. Furthermore, the
itemisation settings can be saved as Favourites, making individual settings for various industries available
at the push of a button.

The fixed part groups used for the old itemization up to 2017 are replaced with freely configurable part
groups. You can individually specify via the part filter which parts are to belong to a part group.

In addition to the item number, a freely configurable item text, e.g. for a detailed description of the type
and quality of a service can be generated automatically. Item texts are composed of components of the
type:

n Text

n HiCAD part attribute

n HiCAD drawing attribute

n HELiOS document attribute

n HELiOS project attribute

HiCAD part attributes can originate from the part itself as well as from the main part of an assembly, or a
superordinate element with user-specific properties. Item text settings, too, can be managed as Favour-
ites.

The range of application for itemisation can be limited to selected parts and their sub-parts within a given
number of levels.

Other differences to the old Itemisation up to HiCAD 2017:

n The result of the itemization is influenced by the order of part groups, i.e. each part will be assigned to the first
matching part group. But the order of the item number assignment depends exclusively on the chosen sort cri-
teria. If you distinguishing / sort criteria have been defined, HiCAD will simply go through the part structure for
the assigning of item numbers.

n The new itemisation does not allow consistent states, that is, in case a a rule-compliant number assignment all
itemised identical parts will have the same item number.

n The Lock given numbers option is now available as the Assign previously assigned item numbers again
option with a "reverse logic", so to speak. It is now possible to change the option subsequently.

n The possibility to Reference during itemisation is not available. Referencing and itemisation use different,
incompatible methods for identical part search.

n An itemisation by assemblies is currently not supported by the Standard Itemisation as of HiCAD 2018.
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Settings from TXTPAR.DAT moved to Configuration Editor
In previous versions the settings for texts and annotations could be set in the TXTPAR.DAT file. As of HiCAD 2018
this file is no longer available. Also, the corresponding setting options at Settings > Basic settings > 2-D have
been removed.

Instead, these settings are now available in the Configuration Editor, namely, at

n Drawing > Annotations > Text > Font and

n System settings > Annotations > Text.

Macro for body rebuilding not available anymore
The macros

n Body rebuilding (2dinfo_krpneuaufbau1)

n Body rebuilding all parts (3dinfo:krpneuaufbau)

are not available as of HiCAD 2018.

What's new? 37 / 268

News Overview



Derived drawings - Shortened views of beams and other part types
The parameters for the shortening of beams and other part types have been combined in the Settings for views dia-
logue window.

Please note:

In HiCAD 2018 the Settings for views dialogue window for the Drawing derivation function has changed. If you load
workshop drawings or model drawings with workshop drawings created with a version before HiCAD 2018 and then
use the Change settings - Active view function, the Shortened view area of the previous version will be shown in
the Settings for views dialogue window:
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Derived drawings - Simplified definition of front view
The definition of the front view and the top view for assemblies, general 3-D parts, beams, profiles, plates and
sheets has been simplified.

For this purpose the functions in the context menu for parts (right-click part) at Properties >Alignment of derived
drawings has been expanded accordingly. You have now the option to select an arbitrary plane for the definition of
the front view or the top view. The same functions as the ones for the determining of processing planes are avail-
able to you.
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Suppress temporary preview for part placement
When selecting certain functions, a shaded polyhedron model preview will be attached to the cursor. For instance,
this is the case when inserting or transforming parts, inserting new parts in the preview mode, or inserting standard
parts.

This preview can be hidden temporarily by pressing and holding down the SHIFT key. This may be useful when work-
ing with complex models due to performance reasons. When the key is released, the preview is visible again.

This behaviour can also be inverted by a corresponding setting in the Configuration Editor at System settings > Visu-
alisation > Temporary preview for part placement Possible setting options are:

n Hide with SHIFT key
When a preview for part placement is shown it can be hidden by pressing the SHIFT key. This is the default set-
ting.

n Show with SHIFT key
No preview for part placement will be shown. By pressing and holding down the SHIFT key, however, it can be
shown temporarily.

New docking window: Exploded view
The 3-D function Exploded view has been revised. Amongst other things, all displacements of the exploded view
will now be documented. The corresponding log will be, similar to the Feature log, displayed in the new Exploded
view docking window. You can also change exploded views via this docking window.

Exploded view docking window
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2-D

Service Pack 2 2018 (V 2302)

New catalogue for shim rings
Shim washers could previously be found in the catalogue Fasteners > Retaining rings. As of HiCAD 2018 SP2 a
separate catalogue exists for Shim rings.

Therefore, the 3-D function 2-D Part > Standard Parts > BoltScrew > Retaining rings has been renamed to 2-

D Part > Standard Parts > BoltScrew > Retaining rings / Shim rings .
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Dimensioning / Annotations

Underlined text blocks

In the settings for annotations you have now the option to underline individual text blocks. This was previously only
be possible for the entire annotation.

In older HiCAD versions (before HiCAD 2018 SP2) the underlining of text blocks is ignored. While the underlining is
still visible and printable when loading the model drawing, the corresponding text blocks will be shown without
frames after updating of the annotation.

Decimal places

For attribute values with decimal places you have now the option to determine the number of decimal places at the
bottom right of the dialogue window. You can specify whether non-relevant decimal places (e.g. final zeroes) are
also to be displayed by activating or deactivating the checkbox.

Font size selection
HiCAD now offers the nominal font sizes according to DIN EN ISO 3098-0 for the font size selection of texts, dimen-
sions, annotations etc. in the Text Editor and Annotation Editor.
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Service Pack 1 2018 (V 2301)

Change language of texts

The Change language of text function and the program WBEdit.exe now also consider auxiliary texts in 2-D/3-
D dimensions, as well as texts instead of dimension figures.
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Major Release 2018 (V 2300)

Settings from TXTPAR.DAT moved to Configuration Editor
In previous versions the settings for texts and annotations could be set in the TXTPAR.DAT file. As of HiCAD 2018
this file is no longer available. Also, the corresponding setting options at Settings > Basic settings > 2-D have been
removed.

Instead, these settings are now available in the Configuration Editor, namely, at

n Drawing > Annotations > Text > Font and

n System settings > Annotations > Text.

Use the Default parameters function (2-D Dimensioning + Text > Edit (Text) Settings > ...) to load the set-
tings from the Configuration Editor at Drawing > Annotations > Text > Font.

The values of the drop-down lists for font size, text width coefficient and line spacing in the Text Editor and Annota-
tion Editor can be arbitrarily expanded in the Configuration Editor at System settings > Annotations > Text > Pre-
ferred text sizes. After restarting HiCAD the new default settings will be used.

Default fonts in TTFONT.DAT
The supplied TTFONT.DAT file previously contained the 3 fonts

n Arial

n MS Mincho

n Arial Narrow

Since the second TrueType Text Font MS Mincho is rarely used, it was replaced with the Arial Unicode MS font.

From Version 2300 onwards, you will find the following fonts in the TTFONT.DAT file:

n Arial

n Arial Unicode MS

n Arial Narrow

Translate annotation tags
Texts, text blocks and annotation tags will be shown in the selected language in the Text Editor or Annotation Editor,

respectively, after their translation with the program WBEdit.exe.
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3-D

Service Pack 2 2018 (V 2302)

Views

Performance for rotations

Shaded views can now be rotated much faster - especially shaded views with visible edges. Three different model
drawings - consisting of 20.000, 60.000 and 90.000 parts, respectively, were submitted to performance tests. Some
of these parts were highly complex, imported elements. Here are some concrete examples of the tested drawings:

20.000 parts with some large, imported parts (Image: TGM Kanis Turbinen GmbH, Nuremberg, Germany)
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60.000 parts (Image: CAD Planung Arnold Matei, Mannheim, Germany)

Compared with HiCAD 2017, a significant increase of the frame rate (the number of images created during rotating)
for the tested drawings could be achieved:

n Shaded with edges: Speed of rotation increased by a factor of 3.7 and

n Shaded without edges: 27% additional images per second.
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Horizontal/vertical alignment of sectional views

Sectional views can now also be dropped horizontally or vertically. For this purpose the context menu that you can
open while the view is "attached" to the cursor has been extended accordingly.

After calling the Drop horizontal/vertical function you can select the the rotation- upwards, downwards, to the left
or right - with the cursor and drop the view. The viewing direction of the section will be determined in the moment of
the function call, that is, it depends on the side of the reference edge on which you called the context menu with a
right-click. The image below shows some different possibilities.
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Captions of sectional / detail views

The View caption dialogue window has been redesigned.

n Like annotations, the individual text blocks of view captions can now be displayed in a frame. Each text block
can be shown with or without a frame or underlined. Possible frames are rectangles, rectangles with double
lines, filleted rectangles or circles.

n You have now the option to use drawing, project or document master attributes for captions. Since sectional or
detail views do not belong to particular parts, part and article master attributes will not be supported here.

In older HiCAD versions (before HiCAD 2018 SP2) the underlining of text blocks will be ignored. Although the
underlining will still be visible when loading the model drawing, and they can also be printed. But after updating the
annotation the corresponding text blocks will be shown without frames.
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Exploded view

New Ribbon

All possible functions for exploded views can now be found in a new Ribbon.

Exploded view creation in video

Use the new Video function to save the creation of exploded views as videos (similar to Simulations).
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Delete mounting tracks / Change representation

New are the Mounting tracks functions in the same-named function group of the Exploded view Ribbon:

Delete mounting track

Change mounting track parameters

Default mounting track parameters

New context menu for logs of exploded views

In the Exploded view docking window you can now open a new context menu. Right-clicking an item in the log of
the exploded view, the following context menu will be displayed:

These functions enable you to partly or completely recalculate exploded views, e.g. after changes to the original
model, or edit transformations.

Calculate up to this transformation

The exploded view will be calculated up top the marked transformation. The insertion position will
then be placed before the marked transformation.

Calculate next transformation

Only the transformation behind the insertion position will be calculated. The insertion position will then
be placed after this transformation.

Recalculate up to insertion position

The exploded view will be calculated up to the insertion position.

Calculate to end

The exploded view will be recalculated completely.

Edit transformation

Use this function to edit the movements and rotations of an exploded view. When you call the func-
tion, a dialogue window will be displayed for this purpose.

Rename transformation

Use this function to rename transformations.

Delete transformation

This function deletes the transformation that was marked in the log. Multiple selections are also pos-
sible.
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Delete exploded views

Exploded views can be restored to normal views with the new Delete exploded layout function. You find the

function at Views > Representation > Shaded > ... and in the context menu at Representation > Others > ....

Create / process parts

New dialogue window for solid primitives

The New solid primitive dialogue window has been revised.

n The icons have been redesigned.

n Use the Create as main part checkbox to determine whether the part is to be inserted as a new main part or as
sub-part to the active part. The Create new solid primitive, as sub-part function on the 3-D Standard tab is
therefore no longer available.

n The dialogue window will now remain open after insertion of a part, enabling you to insert more parts without
having to call the function again. Click the Close button to close the dialogue window. If you prefer an auto-
matic closing of the window after part insertion, activate the Close window after creation checkbox.
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Move+Rotate part - Changed behaviour

When using the Move+Rotate part, via fitting points function, the specification of the 3 fitting point pairs will now be
graphically visualized. During fitting point specification in the model drawing, you can right-click to open a context
menu with further point specification functions.

Use the Origin function to place the fitting point in the origin of the active coordinate system. Use the Step back
function to select a new fitting point on the part

Standard Parts / Standard Processings

New catalogue for shim rings

Shim washers could previously be found in the catalogue Fasteners > Retaining rings. As of HiCAD 2018 SP2 a
separate catalogue exists for Shim rings. Therefore, the 3-D function 3-D Standard > Standard Parts > BoltScrew

> Retaining rings has been renamed to 3-D Standard > Standard Parts > BoltScrew > Retaining rings /
Shim rings.
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New material EN AW-5005 H14

The material EN AW-5005 H14 has been added to the Aluminium alloys table (in the catalogue Materials> Non-
ferrous metals).
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Dimensioning / Annotations

Enhanced variable dimensioning

The variable dimensioning now also allows you to determine linear structure dimensions, i.e. chain, parallel and run-
ning dimensions. To do this, activate the Structure dimensions checkbox in the dialogue window.
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Extended settings for annotations

n In the annotation settings you can now specify that only individual text blocks are to be displayed as underlined
text. In previous version only the complete annotation could be formatted in this way.

n If you want to display attribute value with decimal places, you have the option to display non-relevant decimal
places (e.g. final zeroes) as well. To do this, activate the same-named checkbox.

In older HiCAD versions (before HiCAD 2018 SP2) the underlining of text blocks will be ignored. Although the
underlining will still be visible when loading the model drawing, and they can also be printed. But after updating the
annotation the corresponding text blocks will be shown without frames.

Graphic preview for polygon models

Performance

HiCAD 2018 SP2 supports display lists for the graphic preview of polygon models. Especially if there are many poly-
gon models, e.g. in element installation drawings, a performance increase by a factor of up to 3 can be achieved
(with a suitable graphic card).
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Presentation of 3-D models

Textures on Sheet Metal parts

The applying of textures to individual sub-parts of Sheet Metal parts has been optimized in such a way that the res-
ult will be consistent both with regard to the alignment of the texture and the transitions between neighbouring
parts.
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Service Pack 1 2018 (V 2301)

Exchange 3-D parts

Subsequent referencing of already linked detail drawings

This function searches, via the article master of the active part, a KRA file linked via HELiOS, and automatically
exchanges the active part with the KRA file. In contrast to the functions Exchange 3-D part, via document master
and Exchange 3-D part, via article master, no document or article selection and no placing of the exchanged part
will be necessary here.

The function is particularly useful when you subsequently reference parts, for which a linked detail drawing already
exists, in the assembly of the original model drawing. In this case it will be ensured that the part that exists in the
detail drawing will be exchanged with the referenced part. HiCAD will also attempt to preserve the dimensions of
the part to be exchanged.

Please note:

Here, "detail drawings" are not the detail drawings that are created with the Drawing derivation function on the
Drawing tab, but manually created drawings which have either been created via Drawing > Save/Reference > Part
and the Detail drawing... option, or by pasting of individual parts into a drawing file from the Clipboard. When using
the Clipboard, please remember that dimensions will not be taken over.

When you call the function, HiCAD will check via the article master of the active part, whether a linked KRA file
exists in the HELiOS database.

n If such a file is found, the active part will be automatically - without any further steps in the dialogue window
being required - replaced with the part from the KRA file. In the process, HiCAD will attempt to preserve the
dimensions of the active part. if this is not possible, the dialogue window for the updating of the dimension asso-
ciativity will be displayed.

n If the linked document is no referenced part, the placing of the exchanged part will be requested.

Notes on dimension reconstruction:

If a part has sub-parts and if the detail drawing has been created with a version older than HiCAD 2018 SP1, dimen-
sions cannot be reconstructed, i.e. they cannot be assigned to the corresponding parts. In this case you should
open the Configuration Editor, go to System settings > Referencing and activate the Recover dimensions and
weld symbols before calling the Exchange 3-D part, via DB link function. The dimensions and weld symbols will
then be assigned to the superordinate part.
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Sketches

Sketches as guidelines for the "C-edge sweep" function

Spirals can also be used as guidelines for the C-edge sweep function. This is now even possible if further sketch ele-
ments have been attached to the start or end of the spiral. Please note however that in such cases these elements
must have been linked to the start or end of the spiral via a Coincidence constraint!

In the example shown below, further edges have been added both at the start and at the end of a spiral. The start
point of the edges lies in the start (or end) point of the spiral, where Coincidence constraints have been assigned.
Then, the C-edge sweep function was used to place a circular cross-section along this "expanded spiral".
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Tools

New dialogue for part, view and feature variables

The dialogue of the Part variables function has been largely adjusted to the one of the Part variables docking
window.

The dialogues for view variables and feature variables have been adjusted accordingly, too.

Show/Hide axes

In the 3-D Standard > Tools > Crossh. > ... pull-down menu you can now find new functions that allow you to
show and hide axes:

Hide axis - Individual

Hides individual axes. Select the axes you want to hide.

Hide axis - Group

Hides a complete group of axes that form a crosshairs. For instance, if you select one axis of a
crosshairs of a sphere, all axes will be hidden.

Hide axis -All in active part

Hides all axes / crosshairs of the active part.

Show axis - All in active part

Shows all axes / crosshairs of the active part again.

The hiding of the axes is recorded in the Feature log in the form of an entry called Hide crosshairs.

If one of the Hide axis functions is applied to axes which have been automatically generated by a different pro-
cessing (e.g. after insertion of a bore), this step will not be entered in the Feature log as a new feature, but as a sub-
feature of the creation feature. In this way it is ensured that hidden axes will actually remain hidden after feature
recalculations.

If you want to redisplay individual axes / crosshairs, right-click the Hide crosshairs entry in the corresponding fea-
ture and choose Clear. The corresponding feature entry will then be deleted.

To redisplay all axes / crosshairs of the active part in one step and simultaneously delete the corresponding feature
entries, choose the Hide axis - All in active part function.
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Show/Hide isolated points

In the 3-D Standard > Tools > Point > ... pull-down menu you can now find new functions that allow you to
show and hide points:

Hide point

Hides individual isolated points.

Hide points, active part

Hides all isolated points of the active part.

Show points, active part

Shows all isolated points of the active part.

The hiding of isolated points will be recorded in the Feature log, in the form of an entry called Hide isolated points.
In this way it is ensured that hidden isolated points will actually remain hidden after feature recalculations. Right-
click the feature entry and choose Clear to remove it and redisplay the point.

To redisplay all hidden points of the active part in one step and simultaneously delete the corresponding feature
entries, choose the Show points, active part function.

Copy edges

The "Copy from part" function is no longer available. Instead, the selection menu of the Copy edges function
(open with a right-click after calling the function) now contains the new

All lines or edges of part

option. You can use this option to copy all lines or edges of any 3-D part into the active part. In contrast to the old
"Copy from part" function, the new function enters a feature called Isolated edges into the Feature log that contains
the inserted edges.
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Views

New options for exploded views

n For exploded views you now have the additional option to rotate parts.

n You can now also add automatically created mounting tracks in an exploded view. The Move and Rotate dia-
logue windows contain new checkboxed, enabling you to specif if you want to create mounting tracks and, if,
so specify the type of mounting tracks.

n Exploded views can now also be copied like other views. In the process, all exploded view data (trans-
formations) will be copied as well.
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Example of an exploded view with displacements, rotations and mounting tracks

Show/hide processing planes in views

The former "Show/hide edges in view" function at Views > Properties has been renamed to Show/hide elements in

view . New in the dialogue window of the function is the Processing planes checkbox. By activating or deac-
tivating the checkbox you can show or hide processing planes of the active view in one step.

Alternatively, you can access the functions in the context menu for views at Show/hide parts > Others:

Hide processing planes

Show processing planes

To open the context menu for views, right-click the pink dashed frame around the drawing object.

In shortened views, processing planes are
not being shown - regardless of the setting in Show/Hide elements in view.
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Sectional views - Hide/Show coating lines

The "Delete coating line" function has been replaced with the Show/Hide coating lines function. You find the
function in the context menu for coating lines.

Coating lines can be hidden or shown in the active view or in all sectional views. One distinguishes between coating
lines on the inner side and the outer side. When you call the function, the following dialogue window will be dis-
played:

With the settings shown above, the coating lines will be shown in all sectional views on the outer side and inner
side.

If all coating lines have been hidden, the lines can be redisplayed again via the context menu for sheets: In the sec-
tional view, right-click the sheet and choose Properties > Coating line.

Dimensionings / Annotations

Variable dimensioning - Angular dimensioning with X-, Y- and Z-axis or a reference axis

Via the variable dimensioning you can now also determine dimensions of the type

n Angular dimension with X-, Y- and Z-axis, and

n Angular dimension with reference axis

by selecting an edge or a surface.

If you choose Angular dimension with reference axis as dimension type, a reference axis needs to be specified. In
such cases the Select reference axis button will be displayed in the dialogue window, and HiCAD will ask you to
specify a reference axis - either by identifying an edge or by specifying 2 points. The dimension will then be
attached to the crosshairs.

The selected reference axis will remain active until you select a different reference axis or end the function. This
means that if you choose Angular dimension with reference axis in the dialogue again, the previously selected ref-
erence axis will be used again. If you want to use a different axis, click the Select reference axis button and specify
a different axis.

Auxiliary dimension texts

The Change language of text function on the 2-D Dimensions + Text tab can now also be applied to auxiliary
texts in 3-D dimensions.

What's new? 63 / 268

News Overview



Update dimensions

Dimension base points refer to geometric elements, e.g. surfaces, edges or points. If these elements are removed,
the dimensions will lose their reference and will no longer be associative. In such cases the Dimension associativity
- Update functions can no longer be carried out properly, and the Dimension base point objects not found dia-
logue window will be displayed. The dialogue window and the corresponding settings in the Configuration Editor at
System settings > Annotations > Dimensioning, 3-D > Dialogue default setting: Handling of non-associative
dimension base points have been revised in SP1.
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Itemise part

The function Itemise part now proceeds as Itemisation, individual parts (via Drawing > Itemisa-
tion/Detailing > Itemisation). This means i.a. that

conflicts with other positions can be identified.
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Standard Parts / Standard Processings

Hole Patterns on sheets after bending simulation

Now you have the option to integrate hole patterns in a sheet after adjusting the bend zone. Thus, the hole pattern
(analogically to bores) can be applied even in accordance with multiple flanges and bending zones.

In the wake of this enhancement, the requirement that the processed area must be on the whole side, became no
longer necessary.

Another new enhancement is that the usual features, such as Process sketch and Create new sketch in plane are
also accessable via the dialogue window Hole pattern for working with processed and omitted areas.

Furthermore, the function Hole Pattern is only accessable via the Ribbon 3D-Standard; the entry on the ribbon
Sheet Metal has been removed. However, the function is still applicable on sheet metal.

Hole patterns - Flush vs. central placing of hole patterns

Previously the start hole for insertion of hole patterns was always placed flush on the right and above the origin of
the Pattern CS. As of version HiCAD 2018 SP1 the dialogue window offers the additional Flush checkbox. If you
deactivate this checkbox, the start hole will be placed centrally into the origin.
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New preview images

The tables of the HiCAD Standard parts catalogues are to contain new preview images and descriptive detail graph-
ics. In the first step these were implemented for the Fasteners catalogue. The same which will soon be done for the
other catalogues.
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Major Release 2018 (V 2300)

Standard Processings

Thread representation in shaded views

Threads in shaded views can be represented either with thread texture or transparently. The representation can be
predefined via the configuration management under Visualisation > Views with the parameter Thread rep-
resentation in shaded views.

n With thread texture
This setting - the ISD-side default setting - depicts pitch and chirality of threads realistically. However, this only
concerns the shaded view and not representations such as glass model, hidden line or quick hidden line rep-
resentation.

n Transparent
The threads will be depicted transparently as usual.

Flanged shaft - (1) Transparent view, (2) With thread texture
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Irrespective of the default setting in the Configuration Editor, the thread representation in shaded views can be
determined separately for each view. For this, use the function Shaded representation via Representation > Views
> Shaded repr...

Shaded representation (Active view)

With this function, the active view of thread representation can be changed. For that, the dialogue win-
dow Shaded representation is shown:

Choose the desired representation by clicking the respective option and close the window by clicking
OK.

Shaded representation (All views)

This function complies with the function for Active viewbut affects all views of the model.

Only one thread will be equipped with texture in case of multiple insertion via grid.
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Hole patterns

HiCAD 2018 allows a generation of sheets and plates with hole patterns according to DIN 4185-2 and DIN 24041.
These are sheets/plates with identical holes arranged in regular patterns, which can, for instance, be realized by
punching or drilling tools. Possible hole types are round holes, square holes, slots and special holes. The holes can
be arranged in straight, staggered, diagonally staggered or freely staggered rows. You have a choice between the
selection of predefined holes and hole patterns according to DIN from a catalogue, or the use of self-defined holes
and hole patterns. In the process, the holes will only be placed within a freely defined area if they stay within its lim-
its. In addition, an area for the omission of holes can be defined.

You find the function at 3-D Standard > -Standard Processings > Bore > Hole pattern and Sheet Metal

> Further Tools > HoleP .
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Create and process parts

Optimise part - No longer available for individual surfaces

The Optimise part function can now no longer be applied to individual surfaces, but only to the active part or
to the entire model drawing.

Create parts - Article number with upper case / lower case letters

Various part creation functions could only show the article number in upper case letters. The functions shown below
now also allow a spelling of the article number in upper or lower case letters:

3-D Standard 3-D FFS

Solid primitive Extrude cross-section

Extruded solid Rotate cross-section

Revolved solid Move cross-section

C-edge sweep Transition part

Connect cross-section

Surface from curve mesh

Surface from 3-D polyline frame

Patch
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Delete crosshairs - Now in Feature log

If one of the Delete crosshairs functions is applied to a crosshairs that has been automatically created by a dif-
ferent function, e.g. the insertion of a bore, this deletion will not be entered as a new feature, but as a sub-entry
called Delete crosshairs beneath the creation feature:

This change will also be preserved in case of a recalculation. To delete this processing step later, right-click the
Delete crosshairs entry and choose Clear.

Deleted isolated points considered in Feature log

Up to HiCAD 2017 the deletion of isolated points was not considered in the Feature log, causing an unwanted restor-
ing of deleted points in the drawing after feature recalculation.

From HiCAD 2018 onwards the deletion of isolated points will also be considered in the log of their respective cre-
ation Feature. If an isolated point is deleted in the drawing, the corresponding entry will also be deleted in the
Feature log. After a recalculation, the deleted point will remain deleted.

Please also note that you can now also directly choose during development of sheets whether you want isolated
points of the Sheet Metal part to be shown or hidden. The setting concerns only the isolated 3-D points that the
Sheet Metal part provides. The display of these points can be changed in the Feature of the sheet development. If
an isolated point of the Sheet Metal part is deleted, this point will also be removed from the development when it is
synchronized with the part. Isolated points that have been created in the development subsequently are always vis-
ible.
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Copy edges

The 3-D Standard > Tools > Edge > ... pull-down menu has been revised.

The functions

n Copy, Individual

n Copy, In rectangle

n Copy group

have been combined into one new function called Copy edges . After calling the function, right-click to open
a context menu with various options:

The new function is also supported by Feature Technology: In contrast to the old functions, for edges that are taken
over with the new function a Feature called Isolated edges will be created.

74 / 268 What's new?

3-D



Dimensioning / Annotation

Variable dimensioning - Linear dimension with reference axis

The Variable dimensioning function now also allows the detection of Linear dimensions with reference axis. If you
choose this dimension type, you need to specify a reference axis. To do this, click on the Select reference axis but-
ton. HiCAD will then prompt you to select a reference axis, either by identifying an edge or specifying 2 points. The
dimension will then be attached to the cursor.

The selected reference axis will remain active until you select a different reference axis or end the function, i.e. if
you select the dimension type Linear dimension with reference axis in the dialogue window again, the previously
selected reference axis will be used. If you want to select a different axis, click on the button and define the new
axis.
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Automatic part annotation - Beams and plates

The Automatic part annotation now allows you to determine whether the annotations for beams and plates
are to be applied with or without leader line.

For this purpose the dialogue window has been expanded accordingly:

n Plates preferably without leader line

If this checkbox is active, HiCAD proceeds as follows: If there is enough space on the part, the annotation for
the plate will be placed directly on the part. If there is not enough space, the annotation will be created with a
leader line.

n Beams preferably without leader line

If this checkbox is active, HiCAD proceeds as follows: If there is enough space in the vicinity of the part, the
annotation will be placed along the beam as shown below. If there is not enough space, the annotation will be
created with a leader line.
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Optimize arrangement - Beams and plates

Like the Automatic part annotation function, the Optimize arrangement function now allows you to determ-
ine whether the annotations for beams and plates are to be applied with or without leader lines.

For plates and beams you can determine (as with the automatic part annotation) whether the annotations for
beams and plates are to be applied with or without leader line.

n Plates preferably without leader line

If this checkbox is active, HiCAD proceeds as follows: If there is enough space on the part, the annotation for
the plate will be placed directly on the part. If there is not enough space, the annotation will be created with a
leader line.

n Beams preferably without leader line

If this checkbox is active, HiCAD proceeds as follows: If there is enough space in the vicinity of the part, the
annotation will be placed along the beam as shown below. If there is not enough space, the annotation will be
created with a leader line.

The last specified settings that have been confirmed with OK will be the default settings when the function is called
again.
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Views

Exploded view

The Exploded view function has been revised completely.

This function enables you to display the active view as a so-called "exploded view". This type of view shows the part
and assemblies of the model drawing in "dismantled" state, with the dismantling being based on a translatory dis-
placement of the parts. Exploded views are saved together with the geometry in the .SZA file. Since all part dis-
placements are recorded in an explosion log, they can be changed subsequently if required.

Proceed as follows to define an exploded view:

1. Load the model drawing of which you want to create an exploded view.

2. Create a new view for the exploded representation and activate this view.

3. Call the Exploded view function.

4. HiCAD switches into the Exploded view mode. In this mode you can define the required displacements. For this
purpose, the Exploded view dialogue window will be displayed.
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5. After defining the Exploded view, you can exit the Exploded view mode again.

All displacements of the exploded view will be logged. The log is shown - similar to the Feature log - in the Exploded
view docking window. Via this docking window you can change exploded views subsequently.

What's new? 79 / 268

News Overview



Example of an exploded view (some of the lids have been excluded here)

The "Exploded view" docking window
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Display of coatings in sectional views

The dialogue window for Sectional views has been expanded.

For Sheet Metal parts you have now the option to specify whether the coating in the sectional view is to be shown or
not, by activating or deactivating the Display checkbox beneath Coating in the dialogue window. The coating is dis-
played in the form of an offset edge, the so-called "coating line". The settings for the representation of the coating
line can be found in the Configuration Editor at Drawing > Annotations > Coating line in sectional view.

The representation of the coating line can also be changed subsequently. To do this, right-click on the coating line
in the required view and choose the desired function in the Coating symbol context menu:

Function

Change coating line parameters

Use this function to change the colour, line type and layer of the coating line. When you call the func-
tion, the 3-D edge parameters dialogue will be displayed for this purpose.

Change offset distance

Use this function to change the offset distance, i.e. the distance between coating line and cut edge.

Delete coating line

Deletes the coating line.
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Sheet Metal part (1) with outside coating; Top view (2) with cut edge (3), Sectional view (4) with coating line (5)

Please note:

n The offset calculation for the coating lines is always carried out in the screen plane, i.e. the lines are no "fixed",
permanent 3-D polylines, but will be updated upon rotation of the view.

n In dashed representations the dashing takes place segment-wise, but not over the entire length.
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Shaded representation of threads and panorama mirroring

At Views > Representation > Shaded > ... you can find the following new functions:

Shaded representation (Active view)

Use this function to change the representation of threads and switch panorama mirrorings on or off in
active views.

n Thread

Here you can specify whether you want thread to be displayed with thread texture or transparent
by activating the desired option.

n Mirror panorama

HiCAD offers the option to simulate environments by assigning a panorama to a Sheet or Model
area. The surfaces of shaded models will then mirror this panorama, i.e. their environment. Activ-
ate the Mirror panorama checkbox to switch this effect on, deactivate it to switch it off again.

Shaded representation (All views)

This function corresponds to the same-named function beneath Active view, with the difference that it
affects all views of a model drawing.

In this way, panorama mirrorings can now be switched on or off separately for each view.

The formerly available functions Mirror panorama and Do not mirror panorama are no longer avail-
able in HiCAD 2018.
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Others

Setting options from system file ref3d_attr_akt.dat moved to Configuration Editor

If referenced parts have part attributes which are not to be updated on a regular basis, the synchronization can also
take place in a specific, targeted way. In previous versions this behaviour was determined in the system file ref3d_
attr_akt.dat, and from now on in the Configuration Editor at System settings > Referencing > Synchronization of
attributes.

Click the symbol to activate a table in which you can specify for each part attribute

n whether you want it to be updated only for sub-parts,

n whether you want the settings to be taken from the Configuration Editor or

n whether you never want it to be updated.

ISD default settings (detail)
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For this to happen, a row that is composed as follows must exist for the corresponding part attribute:

Active Via the checkbox of this column you determine whether the synchronization is to be car-
ried out or not.

If you want to activate or deactivate all check boxes in one step, then activate or deac-

tivate the check box in the column heading, e.g. .

As an alternative, you could also use the context menu's function for activation by click-
ing the right button on a table entry.

Name Here you enter the name of the attribute. Attributes predefined by the ISD can also be
chosen via a selection box. To do this, double-click on the corresponding row and choose
the attribute from the list.

Data type Here you select the attribute type (double-click on the row):

n Integer

n Double

n String or

n String (ANSI)

Synchronization
option

Here you select the type of the synchronization. The following options are possible:

n From configuration
The setting from the Configuration Editor at System settings > Referencing > Syn-
chronize item numbers / part attributes when updating file will be applied.

n Main parts and sub-parts
The part attribute will be updated for main parts and sub-parts.

n Sub-parts only
The part attribute will be updated only for sub-parts.

n Never
The specified part attribute will never be updated.

Part attributes that are not listed in the table will be updated for main parts and
sub-parts.

Comment Here you can enter a comment.
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To insert further attribute rows, scroll to the end of the table. There, click on the empty row and specify the required
settings. Proceed likewise for further rows. Click OK to close the Attribute synchronization options dialogue win-
dow.

The sorting of the table can be changed by clicking on a column header.

With a right mouse click on a table entry you activate the context menu, in which you are enabled to delete the act-
ive table row as well as activate or deactivate all check boxes of the column active.

Please note:

Up to HiCAD 2017 the settings for attribute synchronization were defined in the system file REF3D_ ATTR_
AKT.DAT. If you want to take over settings from an existing REF3D_ATTR_AKT.DAT file, this can be done via the

Open file button. After selecting the file, the settings shown in the Attribute synchronization options dialogue
window will be overwritten with those of the selected file after closing the dialogue window with OK.

If you have applied any changes to the file REF3D_ATTR_AKT.DAT, please save the file before making
an update.

Performance

The updating of referenced 3-D parts with many HCM dimensions has been speeded up significantly.

86 / 268 What's new?

3-D



Catalogue Editor

Service Pack 2 2018 (V 2302)

When carrying out an update to Version 2302.0, the catalogues will be cleaned up. Depending on the ver-
sion to be updated, this process may take up to 20 minutes.

Improved and new preview images
The tables of the catalogue Processing, general, too, now have new preview images and descriptive detail graph-
ics.

Sheets with thickness 1.5 mm / 2.5 mm
Sheet thicknesses of 1.5 mm and 2.5 mm per table and material have been added to the following catalogues at
Factory standards > Sheets:

n Aluminium sheet/plate

n Stainless steel sheet/plate and

n Steel sheet/plate

For bulb plates, composite panels and ALUCOBOND sheets/panels such thicknesses are not available.
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New material for sheets - X6CrNiMoTi17-12-2
The material X6CrNiMoTi17-12-2 (1.4571) has been added to the ISD sheet table at Factory standards >
Sheets.

Expanded tables for aluminium alloys / aluminium sheets/plates
n The material EN AW-5005 H14 has been added to the Aluminium alloys table (in the catalogue Materials>

Non-ferrous metals).

n The material EN AW-5005 H14 has been added to the Aluminium sheets/plate table (in the catalogue Fact-
ory standards > Sheets).
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New catalogue for shim rings
Shim washers could previously be found in the catalogue Fasteners > Retaining rings. As of HiCAD 2018 SP2 a
separate catalogue exists for Shim rings.

Therefore, the 3-D function 3-D Standard > Standard Parts > BoltScrew > Retaining rings has been

renamed to 3-D Standard > Standard Parts > BoltScrew > Retaining rings / Shim rings.

Catalogues/Tables for Element Installation / Substructures
Tables can, depending on the catalogue to which they belong, be assigned to specific categories. For Element
Installation and Substructures the categories

n ELEMENT_INSTALLATION_ELEMENTS bzw.

n SUBSTRUCTURE_ELEMENTS

are available.

If a new table is created for these categories, the corresponding table columns will be created automatically.

The tables at Factory standards > Installation Planning - Parts and Processings > Element installation and Fact-
ory standards > Installation Planning - Parts and Processings > Sub-structure, respectively, that are supplied
with HiCAD are already assigned to the corresponding categories.
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Service Pack 1 2018 (V 2301)

New functions in the "View" menu
The View menu has been expanded:

n AutoFit column width

The width of table columns can be manually changed by moving the borders of the columns with the cursor
while holding down the left mouse button. If you activate the AutoFit column width option, the column widths
will be automatically adjusted to the widths of the column cell contents. This is the default setting.

n Hide deleted data records

Data records with the status Deleted are not offered for selection in HiCAD. If you want to hide these data
records in the Catalogue Editor, too, activate the Hide deleted data records option. This is the default setting.
If this option has been activated, the message !!! Caution! Hidden contents: Data records !!! will be displayed
in the title bar of the Catalogue Editor when you open a table with "deleted" data records.
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New usages for railings
Three new usages are available at Factory standards > Usage > Civil Engineering > Steel Engineering > Railing
namely,

n Skirting board profile,

n Handrail profile, and

n Post profile.

You can assign usage-dependent configurations to these railing elements for drawing derivations.

Changed alias names
The alias names of the following catalogues have been changed:

Old New

System Settings / Colours System Settings / System colours

Factory standards / Surface treatment / Profile
installation

Factory standards / Surface treatment / Profile and Ele-
ment installation
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Improved and new preview images
In the future, the tables are to contain new preview images and descriptive detail graphics. In the first step these
were implemented for the Fasteners catalogue. The same will soon be done for the other catalogues.

Double-click the preview image to vie a detail graphic:
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The new preview images will also be shown when inserting parts in HiCAD:

DIN EN 10255 - Medium-weight and heavy threaded pipes
At Semi-finished products > Beams+Profiles > Steel pipes, medium-weight and heavy threaded pipes according
to DIN EN 10255 are now available.
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New fasteners with technical approval for building construction
The catalogue Factory standards > User-defined fasteners has been expanded by the following elements:

n New table SFS GESIPA Blind rivet, large head
at User-defined rivet > SFS

n New table MBE Blind rivet, large head
at User-defined rivet > MBE

n New tables JT4-FR and JT9-FR Hexagon socket tapping screws
at User-defined bolts+screws > Ejot

n Expansion of table SLA54-6-S and renaming to SFS Drilling screw SLA
at User-defined bolts+screws > SFS

New table: Text alignment symbol
New in the Factory standards catalogue, at Symbol > Textalignment, is the Textalignment symbol table.

The symbols defined here will be used for sheet development. The relevant HiCAD function here is the new Text pos-

ition on development function that you can find at Sheet Metal > Process > Extras > ... .

The table is individually expandable.
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Major Release 2018 (V 2300)

Milling tools for processing of composite panels
New in the Factory standards catalogue are the milling tools for processing of composite panels. You can find then
at Factory standards > Composite panels, Groove form.

HILTI Metal Engineering screws - Self-tapping screws S-AD01LHS
New in the Factory standards catalogue are the HILTI Self-tapping screws S-AD01LHS without sealing washers.
You can find then at Factory standards > User-defined fasteners > User-defined bolts+screws > Hilti.
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Symbols for processing of Sheet Metal parts
The Direction arrows table at WERKSNORMEN/SYMBOLE/PFEILE now contains the new symbols Direction sym-
bol Composite panel and Direction symbol One-sided. With the help of these symbols the texturing or coating dir-
ections of panels can be specified. When creating sheet developments, the direction can be used for the alignment
of the development.
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Feature Technology

Service Pack 2 2018 (V 2302)

Performance
Due to the further optimization of the Subtract... feature, the calculation of variants containing many of those fea-
tures in the deactivated state could be speeded up significantly.

Service Pack 1 2018 (V 2301)

Copy edges
The previous function 3-D Standard > Tools > Edge > Copy from part has been removed and replaced with the
new and enhanced Copy edges function: The context menu of this function offers the new All edges or lines of part
option, which enables you to copy all edges or lines of any 3-D part into the active part. This function is also recor-
ded in the feature log, so that edges and lines inserted in this way will remain after feature recalculations.

Performance
Thanks to extensive code revisions model drawings with large Feature logs can now be loaded much faster.

Hide points in Feature log

Isolated points can now also be hidden. To do this, use the functions 3-D Standard > Tools > Point > Hide -

Active part , and 3-D Standard > Tools > Point > Show - Active part .

Points that have been hidden via these functions will be entered in the Feature log of their creation Feature. In this
way they will be preserved when Feature recalculations are performed.
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Hide crosshairs in Feature log
In addition to the deletion of crosshairs, you have now also the option to hide crosshairs. At 3-D Standard > Tools

> Crossh. > ... you can now find the functions Hide axis - Individual , Group , All in active part

and Show axis - All in active part .
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Hidden crosshairs will be entered as parameters of their creation Feature and will be preserved after Feature recal-
culations.
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Major Release 2018 (V 2300)

Insertion of edges

The pull-down menu at 3-D Standard > Tools > Edge > ... has been revised.

The functions

n Copy, Individual

n Copy, In rectangle

n Copy group

have been combined into a new function called Copy edges . When you call this function, the following
options will be available to you in a context menu:

In contrast to the old functions, the new function is also supported by Feature Technology: Edges that have been
created with this new function will have a Feature called Isolated edges.

100 / 268 What's new?

Feature Technology



Permanent deletion of crosshairs in Feature log
If you delete crosshairs that have been automatically created by a processing, e.g. 3-D Standard > Standard Pro-
cessings > Bore/Thr. this deletion will now be saved in the Feature log. This ensures that this change will also be
preserved in case of a recalculation.

In the process, the deletion will not be entered as an independent step in the Feature log, but as a sub-point to the
feature that originally created the crosshairs.

To delete this processing step later, right-click the Delete crosshairs entry and choose Clear.

Permanent deletion of isolated points in Feature log
Up to HiCAD 2017 the deletion of isolated points was not considered in the Feature log, causing an unwanted restor-
ing of deleted points in the drawing after feature recalculation.

From HiCAD 2018 onwards the deletion of isolated points will also be considered in the log of their respective cre-
ation Feature. If an isolated point is deleted in the drawing, the corresponding entry will also be deleted in the
Feature log. This means that isolated points deleted isolated points actually remain deleted after a feature recal-
culation.
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Parametrics (HCM)

Service Pack 2 2018 (V 2302)

Display of positional and dimensional constraints
In the HCM function group of the 3-D Standard and the Sketch tab you can now find the functions 3-D Standard

> HCM > Toggle visibility of dimensions and Sketch > HCM > Toggle visibility of constraints , respect-
ively.

For sketches you have the option to toggle between the following display modes:

n Show positional and dimensional constraints

n Show only dimensional constraints

n Show neither positional nor dimensional constraints

The "Show positional constraints" option that could formerly be found at Sketch > HCM Tools > Settings, has
been removed.

For 3-D parts this function activates or deactivates the display of dimensional constraints.

The settings of the display mode affect the entire drawing, and not just the active sketch or assembly.

102 / 268 What's new?

Parametrics (HCM)



Service Pack 1 2018 (V 2301)

Forced fixing

A new positional constraint called Forced fixing is now available. A force-fixed part can generally not be trans-
formed (moved, rotated, scaled or mirrored) any more - in contrast to parts that have been fixed with the normal
Fix/Unfix function that only prevents transformations of parts when trying to drag them.

If you attempt to transform a force-fixed part, the following message will be displayed:

If you click on Yes, the forced fixing will be removed and the part will be transformed. If you click on No the trans-
formation will not be executed and the forced fixing remains.

Please note however that the forced fixing refers only to one part within an assembly, i.e. the transformation of the
complete assembly will still be possible. If the assembly is transformed, the force-fixed part will be transformed
together with the assembly.

Indication of inconsistent HCM models in the 3-D part structure
In the Configuration Editor at System settings > Assembly HCM and System settings > Sketch HCM, respectively,
you find the new setting option Show HCM errors in part structure?. If you activate this option, inconsistent
HCM models in sketches or assemblies will be marked in the 3-D structure with a corresponding symbol. This mark-
ing will also be applied to superordinate parts and assemblies to indicate the inconsistencies up to the top level of
the affected element.
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Positional constraint "Equal angle" also in 3-D Part HCM

The positional constraint Equal angle can now be used not just in sketches, but also in 3-D parts. You find

this constraint at 3-D Standard > HCM > Fix > Equal angle.

After calling the function hiCAD will asks you to identify two or more angles by specifying two legs for each of them.
You can the apply the positional constraint Equal angle to these legs. HiCAD will then apply the Equal angle con-
straint between them.

Example of the positional constraint Equal angle applied to a part

104 / 268 What's new?

Parametrics (HCM)



Major Release 2018 (V 2300)

New positional constraint: Equal angle
A new positional constraint for sketches and 3-D sketches - Equal angle - is now available.

When you select Sketch > HCM > Fix > Equal angle, HiCAD will ask you to idendify two angles, either by select-
ing an arc or by selecting two straight lines.

The positional constraint will then be applied and displayed both in the drawing area and in the ICN.
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Configuration Management

Service Pack 2 2018 (V 2302)

UNDO setting for 32 Bit versions removed
The setting UNDO memory allocation for HiCAD 2-D has been removed. Since it refers only to 32 Bit versions it is
no longer relevant.

Texts adjusted
The texts at Modelling > Part Properties > Calculate assembly dimensions have been optimised and adjusted to
other, similar entries in this area.

Default settings fro mounting tracks
The ISD default settings for mounting tracks can be found in the Configuration Editor at Drawing > Views >
Exploded view.

Semi-finished Product Article as Sub-item
Semi-finished products can be automatically transferred as sub-items of a part to HELiOS.

This can be set in the Configuration Editor at Active configuration > Base configuration > PDM > HiCAD-HELiOS
interface > Product structure. Here, activate the Semi-finisherd product article as sub-item checkbox.
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If a HiCAD model drawing (.SZA document) or an individual geometry (.KRA document) is saved in HELiOS while
the option has been activated, it will be checked whether a semi-finished product needs to be saved as s structure
sub-item of the corresponding part (=HELiOS article).

The relevant semi-finished product article masters will then be added as sub-item, or updated accordingly in the
product structure of the part.
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Major Release 2018 (V 2300)

Settings from REF3D_ATTR_AKT.DAT moved to Configuration Editor
The settings from the file REF3D_ATTR_AKT.DAT for the synchronization of part attributes for referenced parts
have been moved to the Configuration Editor (ISDConfigEditor.exe). At System settings > Referencing you can find
the find the setting option Synchronization of attributes (SYSTEM > Referencing > RefPartAttrUpdate).

If you click on the symbol, a window with a table will be opened, enabling you to specify for each part attribute:

n if it is to be updated for sub-parts only,

n whether the settings from the Configuration Editor are to be applied, or

n whether it is never to be updated.

Please note:

Up to HiCAD 2017 the settings for attribute synchronization could be found in the system file REF3D_ATTR_
AKT.DAT.

If you want to take over the settings from an existing REF3D_ATTR_AKT.DAT file, this can be done via the Open file

button. After selecting the file, the settings shown in the Attribute synchronization options dialogue window
will be overwritten with those of the selected file. Confirm with OK.

If you have customized the REF3D_ATTR_AKT.DAT file, save the file before performing an update!
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Settings from TXTPAR.DAT.DAT moved to Configuration Editor
The settings from the file TXTPAR.DAT have been moved to the Configuration Editor. There, you can find the set-
tings at:

n Drawing > Annotations > Text > Font

n System settings > Annotations > Text

n System settings > Annotations > Text > Preferred text sizes
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Bill of Materials / Report Manager

Service Pack 2 2018 (V 2302)

Sheet development attributes
The system attributes

§L2D Development length

§B2D Development width

§T2D Sheet thickness

will now be considered for transfer of part attributes to the Report Manager. However, this does not apply to data-
base BOMs.

Service Pack 1 2018 (V 2301)

Sheet Metal parts with images in Excel BOMs
The creation of images for Excel BOMs for Sheet Metal parts with images has been optimized. The created images
are better scaled, the dimensioning is clearly visible and the images are rotated where required to allow a better fit-
ting.
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Variant Editor

Major Release 2018 (V 2300)

Automatic derivation of variants with varying sub-types
The variant editor can be used to derive variants automatically. VAA files can be created, whose attributes are being
modified according to a template in form of a CSV file. So far, the automatic derivation has been tied to fit attributes
which are constant via all sub-types.

As of HiCAD 2018 it is also possible to modify sub-types with regards to the automatic derivation. The variants call
and procedure take place analogously to automatic derivation of variants with constant sub-types. However, addi-
tional attributes are available for varying sub-types:

n VAREDIT_CLUSTERING_KEY
One list of columns of the CSV-file is being assigned to the attribute, which is checked for equality.

n VAREDIT_SUBTYPE_KEY
This attribute can be assigned as value to a series of HELiOS attributes, which determine the columns to be
compared. By contrast to VAREDIT_CLUSTERING_KEY, the CSV file's names of columns are not considered
here.
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Interfaces

Service Pack 2 2018 (V 2302)

STEP export via selection list
The internal structures for the STEP export of entire drawings and the export via selection list have been stand-
ardized. Inconsistencies that occasionally occurred in older versions have been eliminated.

IFC import: Class filter
The new Filter option has been added to the IFC import options.

If this option has been activated, another dialogue for deselection of IFC classes will be opened after choosing
Open.
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In the tree structure you can deselect all classes that you want to exclude from import.

At the top left of the window you can find an input field where you can restrict the displayed classes by an explicit
search for particular classes.

DSTV-NC export via Spooler
The DSTV-NC format can now be exported from the HELiOS Desktop via HELiOS Spooler.

The format-specific export options that were last specified and saved in HiCAD will be used in the process.

DXF export for sheet developments
The DXF export functions for sheet developments have been revised and rearranged. The following three function
are now available:

n Export development as DXF

n Develop sheets and export as DXF

n Export sheet developments as DXF

Further information can be found in the HiCAD Sheet Metal Help.

Furthermore, an interface between HiCAD and Lantek Flex3d is created by the export of the sheet metal blank as
DXF file.
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Lantek Flex3d is a software solution for the automating the programming of sheet metal cutting machines.
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Save 2-D part as DXF file

2-D parts can now be saved in DXF format by choosing Drawing > Save/Print > Save as > 2-D part DXF. 

In the export dialogue you can choose a file for the settings of the 2-D DXF export:
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AutoCAD 2018
HiCAD now also supports the import and export of 2-D DWG files from AutoCAD 2018.

Recognition of incompatible file versions during 3-D foreign data import
When importing foreign data to 3-D formats that are internally converted via the CADfix interface (DXF,DWG,
SolidWorks, Inventor etc.) the file to be imported might exist in a version that cannot be processed by CADfix yet. In
such cases HiCAD will stop the conversion and display the error message An error occurred during import.

In HiCAD 2018 SP1 this general message has been replaced by the following message indicating that there is a
compatibility issue:

Please note:
An overview of all interfaces with additional information (e.g. supported versions etc.) can be found online
in the ISD-Wiki at Product know-how / FAQ/ FAQ - Frequently asked questions.
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IFC import - Optional suppressing of processings
You have now the option to suppress processings when carrying out IFC imports, namely,

n Cuts (trimmings, mitres, notches etc.) and

n Exclusions (subtractions, bores etc.)

Activate or deactivate the corresponding checkbox(es) in the IFC import dialogue window.

Please note that this suppression is only possible for specific processings, and not for faceted parts. For
instance, the processing shown in the image below will always be imported:
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The handling of cuts and exclusions can be preset in the Configuration Editor at Active configuration > Interfaces >
IFC:

2-D DXF export - CLOSED flag for export of (LW)POLYLINES
To enhance compatibility with CAM system, the CLOSED flag (Group code 70, also see https://www.autodesk.-
com/techpubs/autocad/acadr14/dxf/ ) has been appropriately set for the export of POLYLINES and LWPOLYLINES.
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Update to CADfix 11 SP2
With the CADfix 11 SP2 update the following format versions will be available in HiCAD: CATIA V5-6R2017, Inventor
2017, JT v8.5, Parasolid 29, ACIS 2018.

DSTV-NC export - Lettering for plates
In the DSTV-NC interface dialogue, you can now not only specify for Beams + Profiles, but also for Plates whether
the Lettering is to be applied at the front or back of the plate for DSTV-NC exports.

What's new? 119 / 268

News Overview



Sheet Metal

Service Pack 2 2018 (V 2302)

Riveted sheet corner

Use the new Sheet corner function to create a riveted corner, reinforced with a stiffener, between 2 sheet
flanges. The flanges can have different lengths and different bend angles. You can apply this connection type to
milling edge zones and cylindrical bend zones.

When you call the function the following dialogue window will be displayed:

You determine the position of the connection by identifying two flanges on the longitudinal edge of the front side. If

you want to identify a different flange, click the icon beneath Edges and then identify the desired edge.

The connection will be applied to the last identified flange. If the flanges have different lengths, these will remain
unchanged.

If you select a semi-finished product here, the Thickness (3) of the sheet will be automatically entered here. The

standard for semi-finished products can be taken from the Catalogue Editor with a click on the icon. With a
double-click on the Sheet corner feature you can activate or deactivate the semi-finished product later.
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Select the riveted connection from the catalogue. You can choose between SFS and Titgemeyer.

If you have entered all required data you can create the connection. Click Preview to check and, if required, modify
the connection. If you click Apply, the sheet corner will be created, and the dialogue window remains open, allow-
ing you to apply the data to other sheet corners. If you click OK, the sheet corner will be created, and the window
will be closed. Clicking Cancel closes the dialogue window and discards the data without creating the sheet corner.

New DXF export for sheet developments
The DXF export function for developments has been revised completely. You can choose between the following 3
options:

Export development as DXF

When exporting a development as DXF file (Sheet Metal > Sheet development) you have the option

n to save only the section contour (i.e. the drawn bend zones and angles will not be considered), or

n to save the sheet development as it is shown in the drawing (i.e. with the drawn bend zones and angles).

When you have identified an edge of the development, the standard dialogue window for the saving of a file will be
opened. On the right hand side you can choose the export settings - either Only section contour or Complete devel-
opment.
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For the DXF export you need the file HCADACAD.DAT. It contains, for instance, the assignment of the HiCAD ele-
ments for specific AUTOCAD layers. This file can be customized and is located in the HiCAD subdirectory SYS. Do
not save the file with the file name extension .DAT, but with .DA1, .DA2 or .DA3 after its customisation. In this con-
text, please also read this information.

Develop sheets and export as DXF

The Develop sheets and export as DXF (Sheet Metal > Sheet development > Extras) function exports the
section contour or the complete development of Steel Engineering plates. in the process, one temporarily gen-
erated development will be output for the export. You can choose between various sheet development parameters.

For the selection of the sheet development parameters the following options are available:

From draw-
ing

Use this option to load the parameters of the default settings for the drawing. The default set-
ting for new drawings can be specified at Sheet Metal > Sheet development > Default set-
ting.

Manual set-
tings Clicking the icon opens the Sheet development parameters dialogue window.

Favourite
The Favourites saved for the development parameters, e.g. LVD, Bytronic or COBUS are
offered for selection here.

According to
filter list from
configuration

Use this option to load the assignment of the development favourites to the part filters (Sheet
Metal sheets or Steel Engineering plates) from the Configuration Editor (at Sheet Metal >
Sheet development > Filter-Development parameter assignment. Part filters are filters that
have been predefined by the ISD and also the manual filters for part search that have been
stored as Favourites.

The orientation is only unambiguous if it has been determined with the Processing direction function beforehand.

The file name can be configured in the Annotation Editor with a click on the icon. To do this, apply, for
instance, the part attribute "Item number" from the Sheet Metal part. If the part attributes set in the Editor cannot be
applied to the sheets, you have the option to enter your own file name.

For the DXF export you need the file HCADACAD.DAT. It contains, for instance, the assignment of the HiCAD ele-
ments for specific AUTOCAD layers. This file can be customized and then saved with the file name extension .DA1,
.DA2 or .DA3.

The selection of sheets can either take place in the drawing or by adding of all sheets .

When you click on the Export button, temporary developments will be generated and output of all sheets in the

export list, according to the specified parameters. The status icon will indicate problems that may occur. The
files will then be located in the specified directory.

The Close & Report button activates the Report Manager and creates a BOM. If you did not itemize the Sheet
Metal part in HiCAD, quantities will be set on 0 here.
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Export sheet developments as DXF

When exporting multiple sheet developments as DXF files (Sheet Metal > Sheet development > Extras)
you have the option

n to save only the section contours, i.e (i.e. the drawn bend zones and angles will not be considered), or

n to save the sheet development as it is shown in the drawing (i.e. with the drawn bend zones and angles).

Use this function to export several developments with different parameter settings of one Sheet Metal part as DXF,
e.g. LVD and Bystronic.

The file name can be configured in the Annotation Editor with a click on the icon. To do this, apply, for
instance, the part attribute "Item number" from the Sheet Metal part. If the part attributes set in the Editor cannot be
applied to the sheets, you have the option to enter your own file name.

For the DXF export you need the file HCADACAD.DAT. It contains, for instance, the assignment of the HiCAD ele-
ments for specific AUTOCAD layers. This file can be customized and then saved with the file name extension .DA1,
.DA2 or .DA3.

The selection of developments can either take place in the drawing or by adding of all developments .

When you click on the Export button, all developments in the export list will be output as DXF files, according to the
specified parameters.

The Close & Report button activates the Report Manager and creates a BOM. If you did not itemize the Sheet
Metal part of the development in HiCAD, quantities will be set on 0 here

(1) Sheet Metal part

(2) DXF of the entire development

(3) Section contour
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Export to COBUS NCAD
For DXF export you will need the file HCADACAD.DAT. This file contains:

n the assignment of the HiCAD elements to specific AUTOCAD layers,

n the assignment of the HiCAD line types to the AUTOCAD line type,

n the correspondence between the symbols in HiCAD and the blocks in AUTOCAD, and

n the setting determining whether a complete DXF file including the HEADER section, TABLES section etc. is to
be transferred, or only an ENTITIES section.

The file can be customized and is located in the HiCAD SYS directory. After customization, do not save the file with
the extension .DAT, but with .DA1, .DA2 or .DA3.

For the export of developments to COBUS NCAD use the file HCADACAD_COBUS.DAT in the HiCAD SYS directory.
If you want to use this file, save it with the matching file extension (e.g. HCADACAD.DA1).Click here for more
information.

Export of CSV files

To export a CSV file in the Report Manager, call the Settings function and go to the Export - Text tab. Activate
the option Query file name before saving and deactivate Transfer header information. Enter a comma or a semi-
colon for Separator for column. Confirm with OK. Then, call the Exp.Text function and choose the file type
*.CSV.
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Extend coating
When processing a coated Sheet Metal part, the coating will not be automatically applied to the respective pro-

cessing (e.g. to new flanges, bores or corner processings). You can now use the new Extend coating func-
tion to apply the coating to the new or processed elements. To change the coating colour, simply call the Coating
feature.

(1) Front surface of bore (front surface like outer side)

(2) Front surface of flange, bend zone (front surface like outer side)

(3) Outer side of flange
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Welded corner for composite panels
Composite panels such as ALUCOBOND are deformed by means of milling edges. Therefore, the new parameters
Mode and Milling form have been added to the Welded corner dialogue window.

In the Mode filed you can choose between Bend zone, Milling edge zone and Milling edge zone, inverted options.
For the milling edges you can then select, in the Groove form field, the matching milling tool from the catalogue
Factory standards > Composite panels, groove form.

Sheet development attributes
The system attributes

§L2D Development length

§B2D Development width

§T2D Sheet thickness

will be considered for the transfer of the part attributes to the Report Manager. This does however not apply to data-
base BOMs.
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Textures on sheets
The placing of textures on the individual sub-parts of a Sheet Metal part has been changed in such a way that the
appearance of the assigned texture will be consistent - both with regard to the alignment of the texture and the
transitions between neighbouring sub-parts:

Texture on composite panels
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Corner/Mitre
You can now also use the functions of theCorner/Mitre menu to process different Sheet Metal main parts. The func-
tions

n Corner processing/Mitre, betw. Sheets and

n Corner processing/Mitre, Individual - betw. Sheets

have therefore be removed.

In the Through point mode you can switch the start point of the cut plane from the inner side to the outer
side. This means that the first point of the cut plane is located in the theoretical lengthening of the inner or outer
edges of the flanges. Also, all point options are available to you.

Mitre cut between different sheets

First intersection point through outer edge, changed via right-click
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Development

Dimensioning of processings

dialogue window for the sheet development parameters you can find the new Processings checkbox beneath
Dimensioning. Activate this checkbox if you want bores and subractions to be dimensioned.

Dimensionings for processings

Adjust milling tool paths for production

The Adjust milling tool paths for production option refers to sheet corners where three milling edge zones con-
verge. In the development, the lines do normally not converge in a common intersection point.

Therefore you have now the option to adjust the milling lines in such a way that they end in one common point.

It is important that only the milling lines are adjusted, and not the 3-D geometry.

If there are two converging milling lines, the milling lines will be lengthened / shortened, so that they converge in a
common intersection point.

Powder marking lines in developments

The parameters (Colour, Line type, Layer) of the powder marking lines can be specified via Sheet development >

Update > Default setting and, in the dialogue window, Extended settings . The settings apply only to the
3-D sheet development.
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3 milling edge zones

Use this new 3 Milling edge zones function to close a corner in your Sheet Metal construction with 3 milling
edge zones. Just identify the milling edge zones and confirm the processing with OK.

Text position on development

Use this the Text position on development function to determine the position and direction of auxiliary texts
on a sheet development. To evaluate the text position, you need to activate the Auxiliary text checkbox in the dia-
logue window for the sheet development parameters and choose the setting Positioning: Inside. If you select
"Inside" but set no positioning symbol, the annotation will be placed as usual, i.e. HiCAD will search for a free space
on the development.

In the catalogue you find the text position symbol in various sizes in the Text alignment symbol table at
Factory standards > Symbols > Text alignment. If desired, you cann add your own sizes to this table.

The text position symbol is visible on the 3-D sheet, but invisible on the development on Layer 0.

The text position symbol is also considered for identical part search and referencing: Two sheets with different text
position symbols are considered as "unequal".

Enhanced "Attach flange" function
The Attach flange function now has two new reference and fitting modes. The Reference drop down list now offers
the option to attach the flange angle-dependent to the inside or outside. The Fitting mode drop-down list offers the
same options for connecting flanges.
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Source of article number determinable via semi-finished products
The Article number is editable, even if the created sheet is generated from a semi-finished product from the cata-
logue. The catalogue column BZ is not necessarily linked to the article number in the part attributes; BZ can be
linked to any part attribute (e.g. $01 Designation 1).

Sheet from solid
The Sheet from solid function now also copies the article number of the original part.

Hole patterns on sheets after bending simulation
You have now the option to insert hole patterns on developed sheets, i.e. after a bending simulation. In the process,
the hole pattern (like bores) can be applied across multiple flanges and bend zones.

You can access this function at 3-D Standard > Standard processings > Bore > Hole pattern.

Sectional views - Show/hide coating lines
The Delete coating line function for sectional views of sheets has been replaced with the new Hide/show coating

lines function. You access the function by right-clicking the coating line in the sectional view and choosing
the function in the context menu.

Coating lines can be hidden or shown in the active view or in all sectional views. One distinguishes between coating
lines on the inner side and the outer side.

If all coating lines have been hidden, the lines can be redisplayed again via the context menu for sheets: In the sec-
tional view, right-click the sheet and choose Properties > Coating line.

Show/hide edges
TheShow/hide edgesfunction (at Views > Properties) has been enhanced (new Processing planes checkbox) and
renamed to Hide/show elements in view.
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Milling edge zone
Composite panels, e.g. ALUCOBOND panels, can be deformed by means of milling and folding techniques. The res-
ulting bend zone geometrically differ from the cylindrical bend zones. Therefore, HiCAD also offers the option to
choose (besides bend zones) milling edge zones.

Attach flange

When choosing the Attach flange function, you can now choose between bend zone and milling edge modes.

The following options are available:

Bend zone

The bend zone has the specified bend radius.

Milling edge zone

Bend zone with chosen tool (milled inside).

Milling edge zone, inverted

Bend zone with chosen tool (milled outside).

For milling edge zones you have the option to click the Via catalogue button next to Tool and choose the desired
milling tool from the Composite panels, groove form catalogue.
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Milling + Folding

The milling tool path will be displayed if you have activated Bend zone checkbox beneath Representation in the
Sheet development default settings dialogue. The appearance of the tool path is determined on the Milling + Fold-

ing tab of the Extended settings dialogue window that you open with a click on the symbol.

In the upper part of the dialogue you can specify the settings for Line colour, Line type and Layer of the different
tool paths.

You can then specify tool-dependent line parameters for positive and negative bend angles; "milled from top" refers
to the edge that you chose for Sheet alignment: Automatic (see above).

By the specification of tool-dependent settings the milling tool paths in the upper part of the dialogue may be over-
written.

The icon adds a row for a tool from the catalogue. Click the icon to delete a marked row again.
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(1) Positive bend angle, milled from top, Tool V 135°

(2) Positive bend angle, milled from top, Tool V 90°

(3) Negative bend angle, milled from top, Tool V 90°

The bend line text was expanded by the Milling tool attribute by clicking the icon next to the corresponding option.
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Sheet along sketch

The Sheet along sketch now allows you to insert milling edge zones and/or bend zones. The pre-settings for the
complete Sheet Metal part are entered in the Sheet parameters area. In the Bend zones area or (later) via the
Feature, you can specify a tool from the catalogue for each milling edge zone, as well as an individual setting for
the milled side.
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Milling tool for bend zone

The output of the milling tool can be selected in the Annotation Editor via the attributes. The tool that was chosen
for milling edge zone creation will be output at the bend line.

Milling tools for processing of composite panels

New in the catalogue are milling tools for processing of composite panels. These can be found at Factory stand-
ards > Composite panels, groove form.
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Adjust bend zone

The Adjust bend zone function also adjusts the new milling edge zones.

Corner/Mitre function group
The "Process corner" and "Mitre" function groups have been combined into one function group called Corner/Mitre.

Corner/Mitre

Corner processing/Mitre, Sheet

Pull-down menu

Narrow side

Corner processing/Mitre, betw. Sheets (moved to the Corner/Mitre menu as of SP1)

Pull-down menu

Corner processing/Mitre, Individual - betw. Sheets (moved to the Corner/Mitre menu as of SP1)
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Corner processing / Mitre - individual sheet

When you choose Sheet Metal > Corner/Mitre > Sheet a revised dialogue window containing various func-
tions for mitre cuts and corner processings will be displayed:

Proceed as follows:

1. First select a Mode.

Depending on the selected mode, some further options in the dialogue may be greyed out.

n If you choose the Close corner, free mode, you have, beneath Fitting parameters and next to Joint, the option
to close the inner edges flush or according to a specified percentage. You enter the percentage in the Pro-
jection input field.

n If you choose the Close corner, closed mode, you have, beneath Fitting parameters and next to Joint, the
option to close the inner edges flush or according to a specified percentage. Furthermore, you can close the
outer edges flush.

n If you choose the Mitre or Mitre, with neighbours mode, you can activate or deactivate the Plane, automatic
checkbox, specify a setting for Bend zone adjustment (Hollow (outside), Bulgy (inside), Linear, etc.), and
Lengthen the flanges.
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2. Select the two flanges by identifying an edge (right-click front edge).

If you want to identify a different edge, click the icon beneath Edges/plane to identify the edge.

3. Specify the Clearance.

As soon as you have entered all required data, a preview will be displayed.

If you click Apply, the processing will be applied while the dialogue window remains open, enabling you to make fur-
ther adjustments if required. If you click OK, the processing will also be applied, but the window will be closed.

Corner/Mitre dialogue window - Possible options

Mode: Close corner, free bend zone

Fitting parameter Joint

Inner edge, flush

Projection, percent

Mode: Close corner, closed bend zone

Fitting parameter Joint

Inner edge, flush

Projection, percent

Outer edge, flush

Mode: Close corner, drainage area

Mode: Close corner, round

Mode: Mitre

Mode: Mitre, Through point

Mode: Mitre, with neighbours
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Trim sheets

On the Change length function group of the Sheet Metal tab you find the Trim function. When you call the
function, a new, revised dialogue window that offers different trimming options will be displayed:

Proceed as follows:

1. Select a mode.

Depending on the selected mode, some options may be greyed out.

n The modes Individual, with clearance or Individual, flush offer the option to trim the identified sheet flange
with lengthening if desired.

n If you have chosen the mode Plane, with clearance or Plane, flush, all sheet parts of a plane will be trimmed to
a cut surface.

2. Identify the longitudinal edge of the flange to be trimmed, or right-click and select the front side.

If you want to identify a different flange, click on the icon beneath Edge / Plane and identify the desired edge.

3. Now identify the cut plane, e.g. by specifying 3 points, 2 edges or 1 surface.

Here, too, you can select a different plane by clicking on the icon.

4. Activate the Lengthen checkbox if there are flanges that do not reach up to the cut plane.

5. Choose a Bend zone adjustment

6. If required, enter a Clearance.

7. Apply the preview with OK.

If you click Apply, the change will also be inserted, but the window will remain open, allowing you to trim further
sheets. If you select Cancel, the window will be closed, and no change will be applied. If you have activated the
Apply immediately checkbox, the entered data will be applied instantly.
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Subsequent changes can be made via the Feature log: Double-click on the Trim to surface feature and change the
data in the displayed dialogue window.

(1) Edge of the sheets to be trimmed

(2) First edge of cut plane

(3) Second edge of cut plane
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Inner contours in sheet developments
It is now possible to distinguish between the lines of outer and inner contours in developments. Inner contours are
all contours that can be cut out of the sheet and are no standard processings.

This allows you, for instance, to define the adjustment of the layers for the DXF export more accurately.

Colour, type and layer can be specified in the Extended settings of the development parameters.

Inner contours have the line colour Green.
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Analytical development
The analytical development with the functions

n Surface (analytical)

n Surface on neutral axis (analytical)

now offers the option to develop facets lying on a torus.

This takes place approximatively by means of a double development, first with regard to the torus axes and then,
once more, with regard to the cylinder axis resulting from this development.

Therefore, the following warning message will be displayed:

The development con t a ins a t or us t ha t migh t not have been developed cor r ect l y. P l ease check t he r esu l t !

(1) Facet

(2) Development
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Develop bottom side
In the Create sheet development dialogue window you can specify in the Sheet alignment: Automatic mode the
criteria according to which the upper sheet part is to be determined for development creation. For instance, you
can generate the development in such a way that the coated side will be the upper side.

When milling composite panels the coated side is normally located at the bottom. With the Invert upper side
option you can flip the upper side to the bottom.

(1) Sheet Metal part

(2) Development of coated side

(3) Development of coated side, inverted
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Isolated points in sheet developments
In sheet developments you can now define whether isolated points of the Sheet Metal part are to be hidden or
shown. The position of the points (in the development) refer to the flange or the bend zone that was active during
creation. If the main part is active, no points will be developed.

The setting affects only the Isolated 3-D points supplied by the Sheet Metal part. Isolated points in the devel-
opment that have been created subsequently are always visible.

(1) Isolated point, (1a), active sheet flange

(2) Isolated point, (2a), active sheet flange

(3) Isolated point (3a), base sheet active
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Separating lines in developments
If two flanges touch one another (without clearance) during development, a line representing a "separation cut" will
be inserted into the development (see image below). If the front face of a bend zone directly touches a flange, such
a separating line will be inserted here, too.

Through the merging of flanges and bend zones during a sheet development, edges that belong to the outer con-
tour and that will be needed for blank creation can be lost. Therefore, those separating lines will be inserted, as free
edges, at their position in the development.

The separating lines are inserted at positions where contour edges are identical before the merging, and where at
least one of these identical edges originates from a flange.

(1) Separating line
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Acute corner
You can use the Acute corner function to simplify developments.

1. Specify 2 diagonal points to define a rectangle around the corners of the development to be simplified.

The corners will then be simplified. You can then process further corners of the development or end the function by
pressing the middle mouse button.

Processing functions for sheet developments
Processings of developments by the functions

n Delete crosshairs

n Delete point

n Line: Vector menu

that are offered to you when you right-click a sheet development and choose Process development will now be
retained even after a Feature recalculations and development updates.

What's new? 147 / 268

News Overview



Additional symbols for processing direction
The Direction arrows table (atWERKSNORMEN/SYMNBOLE/PFEILE) now contains the new symbols Direction sym-
bol Composite panel and Direction symbol, one-sided. With these symbols the direction of coatings or textures
can be determined. When creating sheet developments the direction can be optionally used for the alignment of
the development.

The following Direction arrows can now be inserted:

n Direction symbol

n Direction symbol Composite panel and

n Direction symbol, one-sided .

Hole patterns
The new Hole pattern function allows you to insert regular patterns of defined holes into parts or sheets.

Possible hole types are round holes, square holes, slots and special holes that can be defined with the help of
sketches. The holes can be arranged in straight, staggered, diagonally staggered or freely staggered rows accord-
ing to DIN.
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Create own moulding tools
You can add your own moulding tools to the library. For this you need at least 2 elements: One sketch used by
HiCAD to create a material subtraction in the sheet to be processed, and a part containing the actual processing.

When applying the moulding tool, HiCAD initially uses the sketch to create a subtraction in the sheet; then, the part
will be positioned and added to the sheet.

Both parts can be parameterized. The thickness of the sheet to be processed will be used as parameter d; other
parameters for the size of the processing can be stored in the catalogue in order to be able to apply a moulding tool
with many different sizes (see Example).

What's new? 149 / 268

News Overview



Collision check when creating welding corners
The welded corner will also be inserted in cases where the affected flanges of the original sheet overlap in
developed state. In such cases an error message will now be issued.

Bending simulation

The Bending simulation function can now be found in the Process function group of the Sheet Metal tab.
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Steel Engineering
Please note:

The functions of the Itemisation/Detailing function group on the Drawing tab are available in all
HiCAD suites and modules.
From HiCAD 2018 onwards you will therefore find the descriptions of these functions in the Basics >
Itemisation/Detailing topic.

News regarding these functions can be found in the Basics - What's New? topic, accordingly.

Service Pack 2 2018 (V 2302)

An example can be found here.

Folded elongated plates - Calculation of attributes
As of HiCAD 2018 SP1, dimensions of elongated plates that have been placed along a 3-D composite edge are cal-
culated with the help of an (internally) developed plate (blank). This also means that, for instance, the width shown
in the part attributes mask, is not necessarily identical to the width shown in the model drawing. As of SP2, this also
applies to folded elongated plates.
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Width / height of beams and profiles
The widths and heights of profiles can now also be managed in the part attribute masks.

New / changed dimensioning rules
Please also read the information on the new and changed dimensioning rules for plates and railing segments in the
News of the HiCAD Basics Help.
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Design Variant for Stabilizing pipe connection
The Design Variant Stabilizing pipe connection has been redesigned.

The created connection consists of

n one gusset plate on each beam (1),

n the connecting pipe with notch (2) and, if required, top plates (4).

n one connecting plate (3) on the stabilizing pipe or a T-profile or

n one (optional) bolting on the gusset plate or the connecting plate (5).

What's new? 153 / 268

News Overview



Glass from sketch: Taking over of chamfer and offset parameters when exchanging or processing
sketches
When using the functions Exchange sketch or Process sketch in the Feature log of a glass that has been created

with the Glass from sketch function, the parameters for chamfers and offsets will now be taken over.

Excluded are offsets that were assigned to the individual line elements of the sketch with the Individual option. In
this case, all offsets will be set to 0.
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DAST connections - Guidelines for weld seams
The DAST guidelines for weld seams have been implemented for the following Design Variants:

n Front plate connection to web/flange (2320),

n Front plate connection to flange (2330),

n Double-sided front plate connection to web/flange (2322) or

n Purlin joint, 2 plates with mitre cut acc. to DAST IH (2201)

If the weld seam settings are changed in such a way that they are no longer in accordance with the DAST

guidelines, the DAST designation will be marked with a symbol. When you move the cursor over the symbol, a
message will be displayed, e.g.:

Cross-bracing 2602 - Rework

If you rework a cross-bracing subsequently (double-click on Feature) and then choose a different number of beams,
reworks and dimensionings that may exist on elements of the cross-bracing may be lost. In such cases HiCAD will
display the following warning message:
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Glass from sketch

The Glass from sketch function has been revised. You have now the option to build glass panes with as many
layers as you like.

Glass panes can either be individually configured or used in the form of semi-finished products from the catalogue.
An individual configuration can be directly taken from the dialogue window as a new semi-finished product stored in
the catalogue.

The previous function Glass from sketch is currently still available as the "Glass from sketch (old)" function.

Elongated plates - Attribute calculation
For elongated plates that have been inserted along a 3-D composite edge, the dimensions are now determined by
means of the (internally) developed part (blank). This also means that, for example, the width shown in the Part
attributes mask needs not necessarily be identical with the width of the part in the model drawing. The image below
shows such a case: An elongated plate with a width of 200 was initially placed along a C-edge. A subtraction via
translation was then applied to the part, which changed the width of the part.
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New Design Variante - Cross-bracing (2602)
The new Cross-bracing (2602) design variant connects two, three or four beams by means of a cross-bracing. The
cross-bracing can be created with a turnbuckle or a tensioning element, and with one or two diagonals.
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Changed dialogue windows for Design Variants
In those Design Variants that offer the option to insert galvanization holes, the minimum distance to the flange or
web required in the dialogue is now always the distance between bore edge and flange (or web). In some of these
variants this distance used to be interpreted as distance between the centre of the bore and the flange (or web).

Left: Before HiCAD 2018 SP1; Right: As of HiCAD 2018 SP1

This change concerns the following variants:

n Base plate + anchor plate (2101),

n End plate (2102),

n Purlin joint, 2 plates with mitre cut acc. to DAST IH (2201) and

n Column connection, Frame corner (2203) and (2204).

Please note:
When you load a model drawing containing one of the above Design Variants created with a HiCAD Ver-
sion before 2018 SP1, nothing will change. But when you process such a Design Variant, the distances
to centres of bores will be shown in the dialogue, and will also still be interpreted as such- even if the dia-
logue window shows a different distance!

The dialogue windows for the Column connection, Frame corner (2203) and (2204) offer an additional tab for the set-
tings of weld seams on stiffeners:
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Parameter configuration for Steel / Metal Engineering
The following default settings of parameter configurations for Steel and Metal Engineering have been changed in
the Configuration Editor at Automatic drawing derivation > Production drawing:

Parameter Old New

Usage-dependent > name* > View group > Insert BOM In view
group

In drawing
frame

Usage-dependent > name* > View group > BOM: Position in view group Bottom left Bottom right

Usage-dependent > name* > View group > BOM: Position in drawing
frame

Bottom left Bottom right

*name is the name of the usage, or part, respectively, e.g. ASSEMBLY_BEAM or DEFAULT(I_PROFILE).

Furthermore, the BENENNUNG  (Designation) attribute for quantity lists has been removed in the
BOM configuration file Hicad_Stahlbau.RMS.
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Drawing derivation - Usage-dependent configurations
For Railings the following three new usage types are available in the Factory standards catalogue at Usage > Civil
Engineering > Steel Engineering > Railing:

n Skirting board profile,

n Handrail profile,

n Post profile.

You can assign usage-dependent configurations for drawing derivations to these new railing elements.

The following configurations have been preset for the new usage types in the Configuration Editor at Automatic
drawing derivation > Production drawing > Usage assignment:

Usage CONFIGKEY
Utilized

configuration
Consider for

drawing derivations

Post profile POSTPROFILE DEFAULT (STAHLROHRE) Yes

Handrail profile RAILINGPROFILE DEFAULT (HOHLPROFILE) Yes

Skirting board profile SKIRTINGPROFILE DEFAULT (FLACHSTAHL) Yes

Furthermore, the default setting for the vertical rods used for infills has been changed:

Usage CONFIGKEY
Utilized

configuration
Consider for

drawing derivations

Rod WEBMEMBER DEFAULT Yes

The default setting for Steel Engineering elements of the part type Round steel has also been changed:

Usage Part type
Utilized

configuration
Consider for

drawing derivations

All Round steel DEFAULT (STAHHLROHRE) Yes

Bar lists - Configuration of image texts
The long texts and short texts in the "images" of bar lists are now configurable. The ISD default setting is as follows:

n Long text = Item number and length in brackets, e.g. 102 (500)

n Short text = Item number

The short text will be used if there is not enough space for the long text in an image.
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Major Release 2018 (V 2300)

Licensing

Enhanced Steel Engineering module

From Version 2018 onwards, the HiCAD Steel Engineering module will contain the connections that you can find in
the Civil Engineering functions docking window at Civil Engineering, general.

Steel/Metal Engineering module no longer available

n As of HiCAD 2018 the Steel/Metal Engineering module is no longer available. This module can be replaced with
the two modules HiCAD Steel Engineering and HiCAD Metal Engineering.
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Design variants

Column Connection, Frame Corner (2204)

With this variant two I-beams are connected with a bolted or welded beam frame corner. You can create the frame
corner with or without stiffeners, haunched plates or other components, e.g. haunched flanges, web rein-
forcements and reinforcement plates or filler plates. It is also possible to insert stiffeners at the tension plate and
ribs at the front plate, and also weld seams as well as to apply galvanization holes.

In contrast to Frame Corner (2203), the connection is made with a square haunch and the tension plate can also be
conical here.

The connection to the girder can be either made with or without front plates.

n with two front plates (bolted),

n with one front plate (welded)

n without front plate (welded)

Requirements for the installation of a frame corner are:

n Both beams must be the type I-beam.

n The webs of the beams must lie in one plane.

n The beam axes must not be parallel and must not lie in one straight line.

Example of a frame corner with an added tension plate

(1) girder, (2) column, (3) front plate at column, (4) two front plates at girder, (5) tension palte, (6) haunch, (7) haunched
flange top, (8) haunched flange bottom, (9) web reinforcement, (10) stiffeners, (11) ribs
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1. Identify the beam (girder) in the vicinity of the reference end.

2. Identify the beam to which the first one should be connected (column).

The Column connection, frame corner (2204) dialogue window will be displayed.
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Advancement of design variants 1211 and 2320 - galvanisation hole in beam

The Design Variants Front plate connection to Web/Flange Side (2320) and Beam to Web with 2 Plates and Stiffener
(1211) allow to apply galvanisation holes in beams. For this, the tab Galvanisation has been enhanced accordingly
within the dialogue boxes.

Tab Galvanisation

Settings for the 1st beam

Here, you can choose via the checkbox Edit if either holes or web cuts should be integrated.
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For integrating the web cuts, you determine the radius and the fitting position (top and/or bottom). For installing the
holes, you determine the installation position (top and/or bottom), the bore as well as the distance to the plate (1)
and beam edge (2).

On the left: web cuts, on the right: holes

Beams

Insert series beams from catalogue

As far as the insertion of series beams is concerned, it has not been possible so far to insert an additional divergent
beam via the function dialogue option Beam.

This problem is fixed in HiCAD 2018 and upwards, i.e., you can use this option to choose another standard part type
before defining the next fitting point.

Representation of beams

So far, it has not been possible to manage the display type of beams (exactly or simplified) via parameter con-
figuration options for steel engineering. From HiCAD 2018 and higher this is not the case anymore.

The default settings have to be defined via the configuration editor under Steel engineering > Representation. The
default settings are Simplified.

166 / 268 What's new?

Steel Engineering



Dimensioning and annotation

Dimensioning and annotation for hidden bores and processings

Dimensioning and annotations for beams, plates and sheets in workshop drawings can (if desired) be placed only
on the visible outer side, i.e. bores/processings that are displayed with dashed lines in the HiddenLine dashed rep-
resentation will not be dimensioned in the corresponding view.

To suppress the dimensioning for hidden bores/processings, the following requirements must be met:

1. In the STWDimSettings.xml file in the HiCAD sys directory the switch IGNOREHIDDENSUBPARTANDBORES
must be set to 1.

</PARAM><PARAM Name="IGNOREHIDDENSUBPARTANDBORES" Typ="INT" Value="1">

2. The HiddenLine or HiddenLine dashed representation must have been chosen.

3. The bore/processing must be entirely hidden. If it is partly visible it will be dimensioned!

The settings for the dimensioning only apply to dimensionings via dimensioning rules.

To suppress the annotations for hidden bores/processings, the following requirements must be met:

1. In the Dimensioning Settings the line type for annotation tags of bores located on the back must have been
switched off.

2. The HiddenLine or HiddenLine dashed representation must have been chosen.

3. The bore/processing must be entirely hidden. If it is partly visible it will be annotated!
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(1) Original beam; (2) Workshop drawing with suppressed dimensioning + annotation of hidden bores; (3) Without
dimensioning + annotation of hidden bores
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Others

Weight calculation for bulb plates

When calculating the weights of bulb plates, the values in the columns GEW (Weight) and HGEW (Avoirdupois
weight) of the catalogue will now be evaluated.

Avoid multiple sectional views in workshop drawings

In the Configuration Editor at Automatic drawing derivation > Production drawing > Avoid multiple sectional
views you determine that sectional views with the same content will only be created once in the workshop drawing.
Sectional views are considered equal if

n the parts visible (displayed) in the sectional views have the same valid item number and

n the sectional views contain the same geometries.

Sectional views for plates outside of the plate end (front plates, top plates, base plates mean the same) are gen-
erally unequal.

If you have chosen the Steel/Metal Engineering template in the HiCAD Parameter configuration dialogue window
(double-click ParKonfigComp.exe in the exe directory of your HiCAD installation to open this window), the Avoid
multiple sectional views checkbox will be active by default.

Staircase/Railing Configurator - Message displayed if main assembly is missing

A prerequisite for the start of the Staircase or Railing Configurator is that the current drawing contains a main
assembly. If this is not the case, the following message will now be displayed.

Click OK and create a new main assembly and call the function again.

No automatic creation of a main assembly will take place anymore, as was still the case in older versions up to
HiCAD 2017.
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Steel Engineering - Management + BIM

Service Pack 2 2018 (V 2302)

New attributes for the article master
When deriving drawings with the Management + BIM module, the document attributes

n HEL_DOKUNUMMER ,

n DRAWINGNUMBER and

n DRAWINGNUMBER_TEXT

will be generated automatically.

As of HiCAD 2018 SP2 these attributes will be transferred automatically to the corresponding article master attrib-
utes of the part when the production/detail drawing is generated. For this purpose the following new article master
attributes have been introduced:

n COMPONENT_WSDDOCUNUMBER,

n COMPONENT_DRAWINGNUMBER and

n COMPONENT_DRAWINGNUMBERTEXT

A prerequisite for the automatic transfer is that the setting Create only one production drawing per part has been
chosen in the Configuration Editor.

Favourites for DXF export
For the export of DXF data for Sheet Metal parts you can now choose in the Configuration Editor which Favourites
file is to be used for the export.
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By default, the ISD defaults have been set here. Choose Sheet Metal > Sheet development > Extras > Sheets
to define further Favourites that will then also be available in the Configuration Editor.

Management + BIM Help
The Management + BIM Help has been revised an restructured.

Important:

n To ensure a smooth and trouble-free management of your model drawings with the Management+ BIM mod-
ule, the working environment needs to be set up properly, and certain rules need to be observed.
It is therefore very important that you read the relevant information given in the Requirements for a Smooth
Operation topic!

n Plan the construction process for your project carefully. Decide whether you want to create your model drawing
in one single model drawing, or - due to the size of the model or in order to save time - on several workstations.
It is therefore very important that you read the relevant information given in the Pre-planning of the Con-
struction Process topic!
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Semi-finished Product Article as Sub-item
Semi-finished products can be automatically transferred as sub-items of a part to HELiOS. This can be set in the
Configuration Editor at Active configuration > Base configuration > PDM > HiCAD-HELiOS interface > Product
structure. Here, activate the Semi-finisherd product article as sub-item checkbox.

Halbzeug-Artikel als Unterposition.
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Templates for attribute assignment - More flexible configuration of document attribute BENENNUNG
(Designation)
If you are using Document and Drawing Management for Civil Engineering (Management + BIM), you have the
option to create the HELiOS attributes BENENNUNG (Designation) and SACHNUMMER (Article number) of the
part drawings from templates files. For this to happen, open the Configuration Editor, choose PDM > Management
+ BIM > Production drawings and set the Create HELiOS attributes from FTD file to Yes (Default). These tem-
plates can be adjusted individually with the Templates, Attribute assignment function.

The actual configuration takes place via Drawing > Itemisation/Detailing > Attr. > Templates, Attribute assign-

ment .

For the configuration of the HELiOS document attribute BENENNUNG (Designation) for a multiple selection of
beams to be output on one drawing sheet, the file BIM_PDM_WSD_Multi_Designation.ftd was previously available.
The default setting in this file has the following effect: If multiple parts/beams exist in the drawing, a list of the item
numbers with reasonably combined items will be output, e.g.:

To make this configuration more flexible, the additional FTD file BIM_PDM_WSD_Multi_Itemnumber.ftd is now
available. If several parts are to be output on one drawing sheet, this file for the configuration of the document attrib-
ute BENENNUNG (Designation) allows you to use a different attribute instead of the item number, e.g. the item
text.
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Management of structure assemblies
Structure assemblies serve the purpose of structuring HiCAD model drawings into construction sections, such as
framework, platform, column, platform girders etc. The advantage of a structure assembly is that it behaves like a
non-BOM-relevant assembly, even if it is actually BOM-relevant. These assemblies will not be considered for the
deriving of production drawings. In previous version the Workflow status of structure assemblies needed to be
changed manually via HELiOS. As of HiCAD 2018 structure assemblies will have the link No drawing required.
Structure assemblies with this link will also be considered for Checkup and Release.

Furthermore, it is possible to automatically create the STEP data of structure assemblies, manage them in HELiOS
and link them accordingly. For this purpose the settings in the Configuration Editor at PDM > Management + BIM >
External production drawings > Collect part types for STEP export have been appropriately expanded.
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Save without HELiOS BIM update

In the Save function group you will find the new Save without HELiOS BIM update function. Use this function
to save the current model drawing to HELiOS, but without updating the BIM links.

For this function an itemization of the parts is initially not required. The itemisation must only be carried out when
you want to create or update drawings. After this, use the Save drawing function to update the links.

Write document attributes on article attributes
If desired, the document attributes of models that are managed with the Management + BIM module can be
assigned to the article attributes of the parts. This can be done via the Configuration Editor at PDM > Management
+ BIM > Write document attributes on article attributes.

The assigning takes place via the String Collection Editor. Click on the symbol in the Collection field and enter
the desired assignments in the following order:

Document attribute;Article attribute
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Each assignment must be defined in one line, e.g.:

Preset here is the assignment for construction sections (aka construction units)

CONSTRUCTION_SECTION;CONSTRUCTION_SECTION

176 / 268 What's new?

Steel Engineering - Management + BIM



Metal Engineering

Service Pack 1 2018 (V 2301)

Functions for sectional views moved
As of HiCAD 2018 SP1 the functions Sealing, Foil and Part with material will be available in the following suites and
modules:

n HiCAD Beams + Profiles,

n HiCAD Metal Engineering,

n HiCAD Steel Engineering,

n HiCAD Steel Engineering - Stairs + Railings,

n HiCAD Steel Engineering suites,

n HiCAD Metal Engineering suites, and

n HiCAD ALUCOBOND® suites.

Therefore, these function can now no longer be found in the 3-D section function group of the Metal Engineering
Ribbon tab, but in the Civil Engineering functions docking window at Civil Engineering, general > Civil Engin-
eering - Sectional views (3-D).
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Licensing
n As of HiCAD 2018, the joints and connections of the Metal Engineering module can be found in the Civil Engin-

eering functions docking window at Metal Engineering / Facade Engineering and Civil Engineering, general.

n As of HiCAD 2018 the Steel/Metal Engineering module is no longer available. This module can be replaced
with the two modules HiCAD Steel Engineering and HiCAD Metal Engineering.
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Element Installation

Service Pack 2 2018 (V 2302)

Preview for element installation and sub-structure
Both in the Element installation and in the Sub-structure dialogue window you have now the option to activate or
deactivate the generation of previews. By default, the checkbox is active, that is, a new preview will be generated
each time you change an entry in the dialogue window.

For a more fluent working with large sub-structures you can remove the checkmark from the button. After this, a
preview will only be displayed if you explicitly click on the button (i.e. previews will no longer be generated auto-
matically). Of course, you can activate the automatic preview generation again at any time.

When working with large installations, removing the checkmark may therefore significantly speed up the process -
especially if several variables need to be changed.

Connecting element installation and sub-structure
Use the Connection function at Civil Engineering functions > Element installation to automatically connect ele-
ment installations and sub-structures. Bores and boltings can also be created automatically in the process.
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After calling the function, simply select the element installation and the sub-structure that you want to connect.

Own variants for the element installation or sub-structure can be prepared by assigning Connection information for
the utilization of this function.

In addition, the following two functions are available to you:

The Connection simulation function simulates the applying of a connection to a part that has not been mounted in
an element installation or sub-structure. This can be helpful when creating own variants.

The Connection geometries function displays the connecting edges of one or several parts or installations. This
function, too, can be helpful for error detection in own variants.

Catalogues/Tables for Element Installation / Substructures
Tables can, depending on the catalogue to which they belong, be assigned to specific categories. For Element
Installation and Substructures the categories

n ELEMENT_INSTALLATION_ELEMENTS bzw.

n SUBSTRUCTURE_ELEMENTS

are available.

If a new table is created for these categories, the corresponding table columns will be created automatically.

The tables at Factory standards > Installation Planning - Parts and Processings > Element installation and Fact-
ory standards > Installation Planning - Parts and Processings > Sub-structure, respectively, that are supplied
with HiCAD are already assigned to the corresponding categories.
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ALUCOBOND® tray panels SZ-20
n Connection type "Attic"

For the connection type Attic, long you can now specify the angle of the folded sheet.

For the connection types Attic, long / Attic, short you can now specify the type of the lateral flanges on the
Extensions for SZ-20 Standard tab.
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The connection between splice sheet and tray panel can be a bonded or a riveted one. The rivets will be inser-
ted on one attic side only, at a 50 mm distance to the edge.

(1) Standard; (2) Without side flanges; (3) Splice sheet, bonded; (4) Splice sheet, riveted
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n Inner corner / Outer corner with joint - Additional angle specification

If you choose Inner corner or Outer corner, with folded sheet for the Horizontal section - Connection
left/right setting, you have now the option to specify an angle for the 35 mm flange.
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n Double sheet folding

Instead of using the stiffeners at the edge you can also apply double sheet foldings. For this purpose the options
on the Extended settings tab have been expanded accordingly.

(1) Double sheet folding; (2) without stiffener, (3) with stiffener
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n Horizontal section - Window connection, Jamb

If you choose Window connection, Jamb for the Horizontal section - Connection left/right setting, you can
insert an additional L-profile. To do this, activate the Window connection with L-profile checkbox on the Exten-
ded settings tab.

Bonded ALUCOBOND® tray panels
Bonded ALUCOBOND tray panels can now be placed on any rectangular or polygonal sketch areas.
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Suspended ALUCOBOND® tray panels
For suspended ALUCOBOND tray panels you can now, besides the tray panel depth, also freely configure the tray
panel height. The options for sub-types have been expanded as well - you can now choose between:

n Sheet insert,

n Corner panel with agraffe, and

n Corner panel without agraffe

Sub-type: (1) Corner panel with agraffe; (2) Corner panel without agraffe; (3) Sheet insert - with stiffeners at edges
and in the middle
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If you choose Corner panel...., a message will be displayed if an invalid tray panel depth has been entered. e.g.:

The selection list for Connection types, left / right now offers the new Outer corner with joint option:

What's new? 187 / 268

News Overview



Service Pack 1 2018 (V 2301)

ALUCOBOND® Tray panel SZ-20 with diagonal sides
ALUCOBOND Tray panels SZ-20 could previously only be installed on rectangular sketch areas. As of HiCAD 2018
SP1 four-sided sketch areas of different shapes, e.g. parallelograms or trapezes, are also possible. This allows you
to create ALUCOBOND® Tray panel SZ-20 with diagonal sides.

Please note the following for ALUCOBOND® Tray panels SZ-20 - depending on the settings during insertion:

n The S- and Z-profiles are trimmed.

n The stiffener profiles are trimmed to the S- and Z-profiles.

n The stiffener profiles are bonded and fixed with angular brackets (Sheet Metal) at the top and the bottom.

n The bores for these brackets are not generated in HiCAD. Reason: They are not created by the machine, but by
a worker after bonding the stiffener profile to the sheet. This bonding cannot be performed accurately enough
to exactly match the previously drilled bores. (1)

Example of a trapezoidal ALUCOBOND®Tray panel SZ-20, (1) No bores are created here!

Management of String variables
As of HiCAD 2018 SP1 the Element Installation also allows a management of variables of the type "String". This
means that if the variant of an installation element contains a String variable, it will also be shown in the Element
Installation dialogue window.
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Sub-structures
Elements that are installed with the help of the Element installation function must often be hanged on a sub-struc-
ture or be fixed to it. In addition to the Element installation function that allows a placing of tray panels onto sur-
faces of sketches, the Sub-structure parts function is now available in the Civil Engineering functions docking
window. This function enables you to place profiles onto edges of sketches and, in doing so, to rapidly create sub-
structures matching the installed elements.
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You have also the option to create your own profiles to use them for sub-structures.
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New options for customer-specific dialogue windows
New options for customizing the parameters area of the dialogue window are now available:

You have now the option to distribute parameters among several tabs. Furthermore, it is now possible to expand
and collapse defined areas.

Customizations of the dialogue window should only be applied by ISD Consultants or users with
good programming skills!
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Specify sheet texture direction
For all ALUCOBOND tray panels you can now specify the direction of the sheet textures on the Extended settings
tab.

If you want to specify a particular direction of the textures, activate the Processing direction checkbox and enter
the angle to the X-axis.

The processing direction has an effect on the position of the trays in the workshop drawing and the later nesting ( 
Cobus Ncad ) by the NC machine systems (Sheet Metal > Sheet development > Extras > All sheets).

General changes in the dialogue windows
n The term Clearance to sketch line has been replaced with the term Joint width towards sketch line.

n In the dialogue windows for the ALUCOBOND tray panels the Connection, bottom has been renamed to Base
point.
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ALUCOBOND® tray panels
n You have now the option to mount stiffeners directly onto ("within") ALUCOBOND® Tray panels SZ-20. For this

purpose the Extended settings tab has been expanded accordingly. In addition, you can specify the processing
types for the suspension (S- and Z-)profiles - with or without riveted connection. Stiffeners are always riveted to
the plate.
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ALUCOBOND® Tray panel SZ-20 - (1) Stiffener profiles at edges of panel; (2) Stiffener profiles on ("inside")
panel

n Stiffeners "within" can also be applied to suspended ALUCOBOND tray panels.

n The selection lists for connection types have bee modified:

Top Base point Left / Right

n For lateral connections and the connection type Outer corner with joint, HiCAD now also inserts the bores for
the joints and the rivets of the ALUCOBOND® plates for the SZ panels in the "corners".
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ALUCOBOND® panels, suspended
As with the ALUCOBOND tray panels SZ 20, it is now possible to insert stiffeners at the edge or directly on sus-
pended ALUCOBOND® panels. The Extended settings tab has been expanded accordingly for this purpose. Fur-
thermore, you can now specify the processings of the profiles for suspension (with or without rivets), choose a sub-
type (corner panel or sheet insert), as well as the tray depth.

Stiffeners are always riveted to the panel.
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Left: With corner panels and stiffeners; Right: With sheet insert, without stiffeners
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ALUCOBOND® panels, riveted
The default setting for riveted ALUCOBOND panes has been changed. The With horizontal folded sheets is now
deactivated by default.
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Service Pack 2 2018 (V 2302)

Isometry and Pipe Spool Drawing

Drawing for pipeline set

The functions Isometry and Pipe spool drawing create workshop drawings for pipelines. Both functions are oper-
ated in a similar way. In older versions, both functions could create a drawing for only one pipeline, though.

As of SP2, HiCAD 2018 offers the option to combine several pipelines into a set of pipelines, which will then be
regarded as "one" pipeline when generating the isometry or the pipe spool drawing. Since you can freely define such
pipeline sets, you are enabled to separate you model drawing into pipelines in a more flexible way and without hav-
ing to have the drawing generation already in the back of your mind.

The decisive difference between the drawing of a pipeline set and the drawing of a separate pipeline is that the
points where the pipelines of a set converge will be interpreted as inner points of a pipeline. Chain dimensions span
these points and connecting points are marked accordingly; no annotation tags with connection coordinates will be
created.

In an isometry, attention is paid to the question whether the set is continuous. If required, distance elements will be
created and marked with by a tilde ~:

To define a pipeline set, simply select the pipelines you want to combine into a set and click on the Link button.
The selected pipelines will then be merged into a set in the list, and will automatically obtain the name Set, followed
by the name of the main pipeline in brackets, e.g. Set (Pipeline_0002).
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The Link button is context-sensitive. When you select a pipeline set, the name of the "Link" button will change to
Cut. Click the Cut button to split the set up into the individual pipelines again.

The main pipeline is marked with the symbol. The purposes of the main pipeline in the isometry and pipe spool
drawing are as follows: 

n The dimensioning is assigned to the main pipeline (or, in the isometry, to the copy of the main pipeline).

n The coordinate system that was defined in the layout plan with the Alignment of derived drawings function will
be taken over by the main pipeline.

n The optionally defined Reference Coordinate system will also be taken over by the main pipeline.

n If the drawing is created in a new model drawing, the name of the created new model drawing will be based on
the name of the main pipeline. This allows you to create the same drawing multiple times with the parameters
of different main pipelines, preventing any conflicts between names.

n The link between layout plan and isometry/pipe spool drawing that is evaluated by the Linked documents func-
tion, is also established via the main pipeline.

You can use the icon to make a different pipeline the main pipeline of the set.
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Please note:

n After creating the isometry of the pipeline set, it will not be possible to spread this isometry over several pages

subsequently. When you call the function Isometry+Pipe Spool Drawing > Settings > Specify division ,
the following message will be displayed:

n Together with the Divide pipeline function the use of pipeline sets is a flexible possibility to arrange iso-
metries or pipe spool drawings appropriately.

Enhanced Flow Editor

The Flow Editor does not only consider individual pipelines, but interprets connected, continuous pipelines as one,
jointly editable pipeline set, as shown by the blue and the green pipeline in the image below:
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Pipeline Tools

Change route via new dialogue

In previous versions, the Dynamic route change function was available via a context menu. In most cases,
multiple function calls were required to achieve the desired result. As of SP2 this context menu will be replaced with
a new, separate dialogue that significantly facilitates the selection of the required settings.

When you call the function, HiCAD will prompt you to select the point to be moved:

After selecting the point you need to specify the target point. Now you can right-click to open the dialogue window
with the different setting options for the route change. The availability of options in the dialogue depends on
whether you selected a pipeline end point (1) or a point in the middle of the pipeline (2) as the point to be moved.
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The images below show where the functions from the old versions can be found in the new dialogue window of SP2:

Also new is the option to correct the selection of the point to be moved. For this purpose you can use the Select
point to be moved function. This function is helpful in cases where the selection of the correct point is difficult, e.g.
if the pipeline ends in narrow parts such as seals and several points are very close to each other.

204 / 268 What's new?

Plant Engineering



Correct route change not possible

If the pipeline contains parts that prevent a correct route change, e.g. because of invalid Part type IDs, or due to fail-
ure to comply with the rules for the creation of own parts, the following warning message will be displayed:

If you click OK you can still carry out the route change - However, we recommend cancelling the route change
and correct the highlighted parts instead.
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Change route of pipeline sets

The dynamic route change now interprets several continuous pipelines as a whole. This means that if the route of
one pipeline is changed, the route of the connected pipelines will also be adjusted accordingly. The behaviour here
is basically that of plugged-in pipelines.

(1) Pipeline set consisting of 3 pipelines; (2) Point to be moved; (3) Target point; (4) Result

Some functions use the route change internally to adjust neighbouring parts, e.g. the Close gap, the Con-
nect pipe, or the Delete functions for certain parts (e.g. Eccentric reducer). These functions now support
positional changes beyond the limits of pipelines.
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Sealing gaskets

Pressure ranges

In previous versions the nominal pressure was of no significance for the search of matching sealing gaskets. To
take pressures ranges into account, the attribute DRUCK_MIN (Minimum pressure) is now available.

When you now search a sealing gasket for a flange, the following, additional search condition will be generated
from the nominal pressure PN of the flange:

(MIN_ DRUCK ist unbelegt oder MIN_ DRUCK <= PN) und (DRUCK ist unbelegt oder DRUCK >= PN)
(Minimum pressure not specified or Minimum pressure <=PN) and (Minimum pressure not specified or Minimum
pressure >=PN)

Sealing gaskets without pressure specifications will thus be handled as if they were suitable for any nominal pres-
sure.

The standard parts that are by default supplied with HiCAD do not include sealing gaskets with a defined pressure
range. Therefore, this new feature is currently only relevant for gaskets that have been created by the user. Accord-
ingly, the attribute DRUCK_MIN (Min. pressure) will not be available in the search masks that are by default sup-
plied with HELiOS. If desired, you can add this attribute with the HELiOS Mask Editor.

If you prepare the database for Plant Engineering by clicking the corresponding button in DBPlantDataImport.exe,
the attribute DRUCK_MIN will be entered, with the designation Minimum pressure, into the database.

An example from practice:

If you do not want gaskets with an own article number for each pressure level to be created, you can avoid this by
means of the DRUCK_MIN attribute.

Furthermore, you have now the option to narrow search results for sealing gaskets by specifying a value for the
attribute DRUCK (Pressure), e.g. by including only gaskets with a defined pressure in your pipe class.

PAA Editor

Attributes for bolted flange connections

PAA files are part archives which are used for Plant Engineering parts with fixed geometries (that is, such parts will
not just be parameterized when they are inserted). PAA files can be imagined as simplified variants without any sub-
types. As such, PAA files support all what you already know from variants. In particular, you have the option to
equip the connections of such parts with the connection IDs for Plant Engineering.

When you wanted to assign the parameters of a flange connection (Connection ID:20000) to a PAA file in previous
versions, there were limitations to the automatic functions for bolted flange connections. These could only be
applied successfully if the flange connections were defined as sub-parts referring to an own part archive (e.g. via
HELiOS link). For instance, this can be seen by the example vessels (BEHALB...) that are supplied with HiCAD.

From HiCAD 2018 SP2 onwards, the PAA Editor allows you to store the parameters of a flange connection (Con-
nection ID: 20000) directly in a PAA file. For this purpose, the Attributes for bolted flange connections checkbox
has been added in the dialogue window of the PAA Editor. If this checkbox is active, the attributes for bolted flange
connections will be added to the attributes list that is displayed when you click on the DB atttributes button.
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Connection-specific attributes (x stands for the connecting point number) for bolted flange connections are:

Bx Thickness of flange plate

Cx Thickness of flange plate, without collar

Fx Thickness of collar

Ax Number of bolts

Kx Hole pattern diameter

Dx2 Bore diameter

NI Nominal diameter in inches for article master (applies to entire bolted flange connection)

L Thickness of flange plate

This attribute is only available for blank flanges and overwrites the attribute B1.

You can also specify the attribute values directly in HiCAD while constructing a part:
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In this case the PAA Editor will take the values directly over into the list of attributes, so that you do not need to
enter them again.

Please note however that the PAA Editor cannot evaluate any formulas!
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New standard parts

Malleable cast iron fittings acc. to EN 10242

Further malleable cast iron fittings acc. to EN 10242 by the company have been added to the standard parts cata-
logue.

The table below contains all parts of this standard. The New column indicates whether a part is new:

Elbows New VAA file

+GF+ Elbow S 1 no GF10242_S01.vaa

+GF+ Elbow S 1A no GF10242_S01A.vaa

+GF+ Elbow S 2 no GF10242_S02.vaa

+GF+ Elbow S 2A no GF10242_S02A.vaa

+GF+ Elbow S 3 no GF10242_S03.vaa

+GF+ Elbow S 40 no GF10242_S40.vaa

+GF+ Elbow S 41 no GF10242_S41.vaa

+GF+ Elbow S 50 yes GF10242_S50.vaa

+GF+ Elbow S 51 yes GF10242_S51.vaa

+GF+ Elbow S 53 yes GF10242_S53.vaa

+GF+ Elbow S 54 yes GF10242_S54.vaa

+GF+ Double elbow S 60 no GF10242_S60.vaa

Crossovers New VAA file

+GF+ CrossoverS 85 yes GF10242_S85.vaa

Crossover tees New VAA file

+GF+ Crossover tee S87 yes GF10242_S87.vaa

Knee New VAA file

+GF+ Angle S 90 no GF10242_S90.vaa
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+GF+ Angle S 90 R yes GF10242_S90R.vaa

+GF+ Angle S 92 no GF10242_S92.vaa

+GF+ Angle S 92 R yes GF10242_S92R.vaa

+GF+ Angle S 94 no GF10242_S94.vaa

+GF+ Union elbow S95, flat seat yes GF10242_S95.vaa

+GF+ Union elbow S 96 yes GF10242_S96.vaa

+GF+ Union elbow S 97 yes GF10242_S97.vaa

+GF+ Union elbow S 98 yes GF10242_S98.vaa

+GF+ Union elbow S100 yes GF10242_S100.vaa

+GF+ Union elbow S101 yes GF10242_S101.vaa

+GF+ Union elbow S102 yes GF10242_S102.vaa

+GF+ Union elbow S103 yes GF10242_S103.vaa

+GF+ Angle 45° S120 yes GF10242_S120.vaa

+GF+ Angle 45° S121 yes GF10242_S121.vaa

T-pieces New VAA file

+GF+ T-piece S 130 no GF10242_S130.vaa

+GF+ Pitcher tee S130R yes GF10242_S130R.vaa

+GF+ Pitcher tee S131 yes GF10242_S131.vaa

+GF+ Pitcher tee, reduced S131R yes GF10242_S131R.vaa

+GF+ Twin elbow S132 yes GF10242_S132.vaa

+GF+ T-piece S133 yes GF10242_S133.vaa

+GF+ T-piece S134 yes GF10242_S134.vaa

+GF+ T-piece, reduced S134R yes GF10242_S134R.vaa

+GF+ T-piece, equal, S 135 yes GF10242_S135.vaa

+GF+ Pitcher tee for distribution battery, reduced S137 yes GF10242_S137.vaa

Branches New VAAfile

+GF+ T-piece 45° S 165 no GF10242_S165.vaa

Kreuze New VAA file

+GF+ Cross S180 yes GF10242_S180.vaa

+GF+ Cross, reduced S180R yes GF10242_S180R.vaa

Y-pipes New VAA file

+GF+ Y-piece S 220 yes GF10242_S220.vaa

Reducers New VAA file

+GF+ Socket, reduced S 240 no GF10242_S240.vaa

What's new? 211 / 268

News Overview



+GF+ Reduced nipple S 241 yes GF10242_S241.vaa

+GF+ Double nipple, red. S 245 no GF10242_S245.vaa

+GF+ Socket, reduced S 246 EN 10242 no GF10242_S246.vaa

+GF+ Reducer, eccentric S260 yes GF10242_S260.vaa

Sockets New VAA file

+GF+ Socket S 270 no GF10242_S270.vaa

+GF+ Socket S 271 yes GF10242_S271.vaa

Nipples New VAA file

+GF+ Double nipple S 280 no GF10242_S280.vaa

+GF+ Double nipple S 281 yes GF10242_S281.vaa

Caps New VAA file

+GF+ Plug, beaded S 290 yes GF10242_S290.vaa

+GF+ Plug, plain S 291 yes GF10242_S291.vaa

+GF+ Plug, with hole S 294 yes GF10242_S294.vaa

+GF+ Cap S 300 yes GF10242_S300.vaa

n Variant GF10242_S92R.vaa replaces Variant GF10242_S92R1.vaa.

n Variant GF10242_S130R.vaa replaces Variant GF10242_S130R23.vaa.

n The file GF10242.lst for part data synchronization lists all above parts - old and new.
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Supplied database

List of variants

New in the HiCAD PlantParts directory is the file starter.lst. This file contains a list of all VAA and PAA files which
are contained in an unmodified, supplied database.

This facilitates an updating of the associated article and document masters and allows an clearing of the database
with the help of PartDataAutoSync.exe or DBPlantDataImport.exe.

Part search

Messages in the Search conditions dialogue window

If the Show search criteria if part search unsuccessful checkbox on the Part search tab of the Plant Engineering
Settings dialogue window has been activated, the Search conditions dialogue window with the utilized search cri-
teria will be displayed after an unsuccessful or disrupted part search.

If parts are managed via HELiOS an additional row shows error messages of the HELiOS database that may have
occurred.

These messages can be as follows:

n You have not been logged into the HELiOS database

n Classification does not exist in HELiOS database

n The link AllgType-Variante does not exist in the HELiOS database

n The link Part-Part geometry does not exist in the HELiOS database

n No document for article found
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New parts

Threaded flanges, pipes and fittings

Variants according to

n DIN EN10255,

n DIN EN 10241,

n DIN EN1092-1/13 and

n DIN 2561 und DIN 2558

have been added to the Plant Engineering Standard Parts. All those parts have threads.
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Straight pipes acc. to DIN EN10255, light, medium weight and
heavy

Variant

EN10255-H.VAA

EN10255-M.VAA

EN10255-L.VAA

EN10255-L1.VAA

EN10255-L2.VAA

Threaded fittings Variant

Hexagon cap EN10241_CAP.VAA

Cross EN10241_CROSS.VAA

Elbow 90° EN10241_ELBOW90.VAA

Angle 45° EN10241_KNEE45.VAA

Angle 90° EN10241_KNEE90.VAA

Angle 90° with inner and outer thread EN10241_KNEE90_MF.VAA

Pipe nipple EN10241_NIPPLE.VAA

Screwed connection EN10241_NIPPLE_HEXAGON.VAA

Double pipe nipple EN10241_NIPPLE_LONG.VAA

Weld-on nipple EN10241_NIPPLE_WELD.VAA

Plug EN10241_PLUG.VAA

Reducer EN10241_RED.VAA

Hexagon reducer double nipple EN10241_RED_NIPPLE.VAA

Reducer socket EN10241_RED_SOCKET.VAA

Socket EN10241_SOCKET.VAA

Hexagon double nipple EN10241_SOCKET_
HEXAGON.VAA

Half socket EN10241_SOCKET_SHORT.VAA

T-piece EN10241_TEE.VAA

Threaded flanges, oval Variant

N2561.VAA

N2558.VAA

Threaded flanges, round Variant

EN1092-1-13-B-PN10.VAA

EN1092-1-13-B-PN100.VAA

EN1092-1-13-B-PN16.VAA

EN1092-1-13-B-PN25.VAA

EN1092-1-13-B-PN40.VAA

EN1092-1-13-B-PN6.VAA

EN1092-1-13-B-PN63.VAA

For part synchronizations you can find those parts in the file threaded.lst.
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Part Tools

Delete parts

Sometimes it is easier to place parts directly instead of drawing a guideline that exactly matches the part to be
placed, and then place the part onto it. When you deleted parts that have been inserted in this (easier) way in older
versions, the information about the pipeline route was lost due to the missing guideline.

Therefore, the functions

Delete part and

Delete several parts

have been enhanced. The functions now create "replacement guidelines" for parts that have been placed without
guidelines, as shown in the example with the elbow below:

Please note that parts whose guidelines do not match their connection direction will be handled in a special way. In
the example shown below this is the asymmetrical reducer. If you delete such a part, you have the option to adjust
connecting points. In the model drawing the adjustment will be indicated by means of arrow symbols. The arrows
show in which direction a connecting point will be moved for this purpose.

216 / 268 What's new?

Plant Engineering



The arrows are selectable. As soon as you move the cursor over an arrow you receive an information about the
expected result of a mouse click.

For instance, if you move the cursor over the left arrow in the drawing shown below, a line highlighted in a different
colour (Special colour Marking 1) appears, showing you the route of the guideline. Also, an info text will be dis-
played, telling you that end points will be moved. In the example below, this text refers to the left end point of the
horizontal pipe, which is also highlighted in the marking colour.

If this info text appears, you should check whether you actually agree with the displacement of the marked points.
Please note that such points can also lie outside the border of visible areas.
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When you now click on the left arrow, the result will look as follows:

If you select the right arrow instead of the left arrow, the result will look as follows:

This time, no end point was moved; therefore, no info text appeared. instead, the vertical guideline section was
lengthened a little bit.

In the background, a route change will be used for the adjustment of the end points. This means that HiCAD will
always attempt to move the connecting point by length changes first. If this attempt fails, pipeline end points will
also be changed and the info text appears.
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For parts that need to be handled in a special way - such as the asymmetrical reducer in the examples below - you
can use additional functions in a context menu that you can open with a right-click:

Function

Generate no
guideline

No guideline will be generated, the pipeline remains disconnected.

(this can be preset in the Configuration Editor at Plant Engineering > Layout plan with
the parameter Delete replaces parts with guidelines.

Apply guideline
without adjust-
ment

A guideline will be created along the dashed blue line. This will usually cause inflexions in
the route.

Observe max-
imum lengths

A route change option that determines whether the maximum lengths of the pipes are to
be observed when adjusting the connecting points by means of length changes.

Show info texts Determines whether info texts are to be shown when you move the cursor over an arrow.

When deleting several parts, one also distinguishes between parts that have been placed on a guideline and parts
that have been placed directly, i.e. without the help of a guideline. If the part selection contains parts that require a
special handling with regard to the Delete part functions, these parts will be excluded from deletion. In this case a
corresponding info text will be displayed. For instance, this is the case if the direction of an automatically created
guideline does not match the connection direction.
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Deactivation of guideline creation

The guideline creation can also be switched off if desired. To do this, open the Configuration Editor, go to Plant
Engineering > Layout plan and deactivate the Delete replaces parts with guidelines checkbox. Please note how-
ever that if you delete parts that were not inserted on a guideline, the information on the pipeline routing will be lost
due to the missing guideline.

Bolted flange connections

For bolted flange connections in Plant Engineering you have the option to reuse connections that have already been
saved during insertion. For this to happen, the Use saved bolted flange connection checkbox on the Flange con-
nection, bolted tab of the Plant Engineering Settings dialogue window must have been activated. This is the ISD
deafult setting.

In this mode HiCAD 2018 SP1 will proceed as follows:

Once used, a bolted flange connection will be saved as referenced KRA file, namely, to the HiCAD subdirectory
RefTeile1. In the HELiOS database, a document master and an article master will be automatically created for this
KRA file, which will be classified as a Bolted flange connection. In the article attributes, the following data will be
saved:

n Nominal diameter of flange,

n Number of bolts,

n Bolt hole pattern diameter,

n Diameter of bolt holes,

n Clamping length (without washers),

n Level of detail (i.e. compressed, without details or with all details), and

n Standard designation defined as search pattern in the settings.

Bolted flange connections matching these attributes will be regarded as "identical parts" with regard to referencing
and updating.

When inserting a new bolted flange connection, HiCAD will use these attributes to check whether a matching art-
icle and document master exists in HELiOS. If this is the case, the matching bolted flange connection (KRA) will be
loaded from the RefTeile1 directory and inserted as a referenced element. If this is not the case, a new bolted
flange connection will be generated and saved as a referenced element.

Due to the referencing, subsequent changes will now affect all identical bolted flange connections (=identical
parts).
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Please note that this changed mode also affects processings applied to bolted flange connections.

Modifications to only one bolted connection

If you want to carry out modifications that are to apply to only one bolted connection, you can break up the ref-
erencing beforehand. To do this, use the context menu (right-click) of the referenced bolted connection in the ICN.
When you are asked whether you want to delete the article master links, it is recommended to answer with Yes,
since the stored article master will probably no longer match the part.

Updating of existing flange connections from older versions

When you load a model drawing that has been created with a HiCAD Version before 2018 SP1, the following adjust-
ments will be carried out automatically - irrespective of whether you have already worked with saved bolted flange
connections or not:

n The origin of the local coordinate system will be placed in front of the first flange face (seen from the bolt
heads). The origin was formerly located between the flange faces.

n Formerly, bolted flange connections had 3 named points. These will be removed.

If bolted flange connections referring to an article master exist in the model drawing, it is assumed that these bolted
connections were inserted while the Use saved bolted flange connections option was activated . In this case, the
following additional actions will be performed:

n The KRA file for the bolted connection in the PlantParts directory will be deleted.

n The bolted connection will be saved as a referenced element. In the process, a new KRA file will be created in
the RefTeile1 directory. If a matching KRA file already existed in the KRA directory, the bolted connection will
only be marked as a reference to it and updated to the state of the existing KRA file.

n The document master linked to the bolted connection will be adjusted, so that HEL_DATEINAME now points to
the KRA file in the RefTeile1 directory.
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Pipeline Tools

Change route - Highlighting of pipelines when maximum length is reached

If the Observe maximum lengths mode has been activated when you use the Change route function, pipes will be
highlighted in the marking colour 5 in the preview when reaching their maximum length.

Change route - Distance calculation according to L1 norm

When changing pipeline routes, the minimum distance calculation takes place in accordance with the L1 norm.
The effect of this is that, starting from the target point, the directions running parallel to the coordinate axes will be
preferred if the target point itself cannot be reached. As of HiCAD 2018 SP1, the local coordinate system will be con-
sidered for the calculation.

The effect of the coordinate system on distance calculation can be explained by means of the following example:

Let us assume that you want to perform the change shown below.
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To do this, fix the horizontal and the vertical sections and move the graphic cursor to the target point. If you try to
change the route in the World CS in this way, you will realize that this will not work. The reason for this is the above
mentioned distance calculation.
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But if you switch to a different coordinate system, e.g. with the function Plant Engineering > Settings > Settings >

> Z points outwards , the change will be successful.
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Isometry / Pipe Spool Drawing

Settings - Item numbers

Formerly, elbows in Plant Engineering BOMs were not distinguished by their insertion angles. This can now be
changed in the settings for isometries and pipe spool drawings. For this purpose, the new Distinguish elbows acc.
to insertion angle checkbox is available on the Item numbers tab of the settings dialogues.

Example:

The pipeline shown below contains 3 elbows with different insertion angles.
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Taking into account of the functions beneath "Alignment of derived drawings"

The functions beneath Alignment of derived drawings in the context menu of assemblies allow you to determine

whether the active view is to be interpreted as Front view or Top view of derived drawings. This means
that a View CS will be defined for the front view or top view of the corresponding assembly.

These functions can also be applied to pipelines. In the ICN, right-click on the pipeline, open the Properties sub-
menu and choose the desired function.

Isometry and pipe spool drawing will then consider the view coordinate system that was defined in this way:

n In the pipe spool drawing, all views will be created with regard to the defined view coordinate system.

n This also applies to the isometry - with the exception of the Retain perspective projection. It serves the purpose
of creating an isometry in the view coordinate system of the currently active view; therefore the selected align-
ment has no effect here.

n The Set reference CS for isometry function that determines in which coordinate system the coordinates
in dimension tags are to be calculated remains unaffected by this.

To Reset the selected alignment, choose the same -named function in the context menu of the pipeline.

The alignment chosen for a pipeline can be marked accordingly in the model drawing.
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Example:

The image below shows a pipeline for which no view alignment has been set. For the isometry, the Isometric pro-
jection 1 has been chosen.

If you now open the context menu with a right-click, choose Properties > Alignment of derived drawings > Front

view , and select the marked surface (1) in the image below, this will affect the isometry:
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In the next image, Properties > Alignment of derived drawings > Top view has been chosen, and then the
marked surface (1):
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Major Release 2018 (V 2300)

New parts

Parts acc. to DIN 32676 (withTri-Clamp connection)

The Standard Parts inventory for Plant Engineering has been expanded by parts according to DIN 32676.

Clamped intermediate pieces Variant

DIN 32676-A N32676-B_STRAIGHT.VAA

DIN 32676-B N32676-B_STRAIGHT.VAA

DIN 32676-C N32676-C_STRAIGHT.VAA

The Clamped intermediate pieces behave like straight pipes.

Fittings acc. to DIN 32676-A Variant

Clamped connection N32676-A_CLAMPJOINT.VAA
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Fittings acc. to DIN 32676-A Variant

Clamped cross N32676-A_CROSS.VAA

Clamped elbow N32676-A_ELBOW.VAA

Clamped reducer N32676-A_REDUCER.VAA

Clamped reducer, excentric N32676-A_REDUCER_EX.VAA

Clamped T-piece N32676-A_TEE.VAA

Fittings acc. to DIN 32676-B Variant

Clamped connection N32676-B_CLAMPJOINT.VAA

Clamped cross N32676-B_CROSS.VAA

Clamped elbow N32676-B_ELBOW.VAA

Clamped reducer N32676-B_REDUCER.VAA

Clamped reducer, excentric N32676-B_REDUCER_EX.VAA

Clamped T-piece N32676-B_TEE.VAA

Fittings acc. to DIN 32676-C Variant

Clamped connection N32676-C_CLAMPJOINT.VAA

Clamped cross N32676-C_CROSS.VAA

Clamped elbow N32676-C_ELBOW.VAA

Clamped reducer N32676-C_REDUCER.VAA

Clamped reducer, excentric N32676-C_REDUCER_EX.VAA

Clamped T-piece N32676-C_TEE.VAA

Valves acc. to DIN 32676-A Variant

Clamped ball valve, hand operated N32676-A_BALLVALVE.VAA

Clamped butterfly valve, hand operated N32676-A_BUTTERFLYVALVE.VAA

Valves acc. to DIN 32676-B Variant

Clamped ball valve, hand operated N32676-B_BALLVALVE.VAA

Clamped butterfly valve, hand operated N32676-B_BUTTERFLYVALVE.VAA

Valves acc. to DIN 32676-C Variant

Clamped ball valve, hand operated N32676-C_BALLVALVE.VAA

Clamped butterfly valve, hand operated N32676-C_BUTTERFLYVALVE.VAA
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Fasteners acc. to DIN 32676-A Variant

Clamp N32676-A_CLAMP.VAA

O-ring N32676-A_ORING.VAA

Fasteners acc. to DIN 32676-B Variant

Clamp N32676-B_CLAMP.VAA

O-ring N32676-B_ORING.VAA

Fasteners acc. to DIN 32676-C Variant

Clamp N32676-C_CLAMP.VAA

O-ring N32676-C_ORING.VAA

Clamped sockets acc. to DIN 32676-A Variant

Clamped dummy socket N32676-A_STUB_END.VAA

Clamped welded fusion spigot, long N32676-A_STUB_LONG.VAA

Clamped welded fusion spigot, short N32676-A_STUB_SHORT.VAA

Clamped female connector N32676-A_STUB_THREADED_FEMALE.VAA

Clamped male connector N32676-A_STUB_THREADED_MALE.VAA

Clamped sockets acc. to DIN 32676-B Variant

Clamped dummy socket N32676-B_STUB_END.VAA

Clamped welded fusion spigot, long N32676-B_STUB_LONG.VAA

Clamped welded fusion spigot, short N32676-B_STUB_SHORT.VAA

Clamped female connector N32676-B_STUB_THREADED_FEMALE.VAA

Clamped male connector N32676-B_STUB_THREADED_MALE.VAA

Clamped sockets acc. to DIN 32676-C Variant

Clamped dummy socket N32676-C_STUB_END.VAA

Clamped welded fusion spigot, long N32676-C_STUB_LONG.VAA

Clamped welded fusion spigot, short N32676-C_STUB_SHORT.VAA

Clamped female connector N32676-C_STUB_THREADED_FEMALE.VAA

Clamped male connector N32676-C_STUB_THREADED_MALE.VAA

To facilitate part synchronization, the Standard Parts have been centralized in the following archive file lists (lst):

n DIN32676-A.lst

n DIN32676-B.lst

n DIN32676-C.lst

n DIN32676.lst, which combines the three standards above.

The lst files additionally contain straight pipes acc. to DIN 11866 which are combinable with the Clamped welded
fusion spigots:

n N11866-A.vaa

n N11866-B.vaa

n N11866-C.vaa
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Pharmaceutical pipes acc. to DIN 11864 und DIN 11865

New in the Standard Part inventory for Plant Engineering are parts acc. to DIN 11864 and DIN 11865.

Bolted connections acc. to DIN 11864-1 Variant

Dummy socket with notch N11864-1_BBS.VAA

Threaded dummy socket N11864-1_GBS.VAA

Socket with notch N11864-1_BS.VAA

Threaded socket N11864-1_GS.VAA

Pipe union N11864-1_RV.VAA

Along with these parts you can find the Grooved nut N11851_NUT.vaa and the Sealing ring N11851_OR.vaa in the
Standard Parts inventory.

Flange connections acc. to DIN 11864-2 Variant

Flange with notch N11864-2_BF.VAA

Flange with groove N11864-2_NF.VAA

Flange connection N11864-2_FV.VAA

Blank flange with groove N11864-2_BNF.VAA

Blank flange with notch N11864-2_BBF.VAA

Along with these parts you can find the Sealing ring N11864_OR.vaa in the Standard Parts inventory.

Clamped connections acc.to DIN 11864-3 Variant

Clamped socket with notch N11864-3_BK.VAA

Clamped socket with groove N11864-3_NK.VAA

Clamp N11864-3_KL.VAA
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Clamped connections acc.to DIN 11864-3 Variant

Clamped connection N11864-3_KV.VAA

O-ring N11864-3_OR.VAA

Clamped dummy socket with groove N11864-3_BNK.VAA

Clamped dummy socket with notch N11864-3_BBK.VAA

Fittings for orbital welding acc. to DIN 11865 Variant

Reducer N11865-RK.VAA

Reducer, excentric N11865-RE.VAA

Elbow 45° N11865-BS-45.VAA

Elbow 90° N11865-BS-90.VAA

Elbow 90°, long N11865-BL-90.VAA

Rohrbogen 180° N11865-BS-180.VAA

T-piece N11865-TS.VAA

Reduced T-piece N11865-TS-RED.VAA

T-piece, short N11865-TK.VAA

Reduced T-piece, short N11865-TK-RED.VAA

Cross N11865-XS.VAA

Cross, short N11865-XK.VAA

The parts according to DIN 11864 and 11865 can be found, combined for part synchronization, in the file
pharmaline.lst. The above mentioned, matching Sealing rings and Grooved nuts are also contained in this file. Fur-
thermore, the straight pipes that are combinable with these parts according to DIN 11866 are contained here.
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Evaluation

Overview of welded connections in BOMs

You have now the option to display an overview of welded connections in BOMs. For this to happen, go to Plant
Engineering > Bills of Materials in the Configuration Editor and activate the checkbox of the parameter Sup-
plement BOMs with an overview of welded connections.

Click here to view an Example.

The display of this overview is only possible in BOMs that have been created with the BOM functions of
the Evaluation function group; it is not possible for BOMs in isometries and pipe spool drawings.
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Accessory sets

Accessory sets for other Plant Engineering articles

During part insertion via HELiOS part search HiCAD Plant Engneering supports the taking over of linked accessory
sets. That is, if an accessory set is linked to a part/article, the corresponding entries will be read out of the access-
ory product structure and stored in the inserted part. This allows the accessories to appear in the HiCAD BOMs.

This mechanism was previously only supported for particular parts. From HiCAD 2018 onwards this will also be pos-
sible for components, i.e. for parts that do not belong to a pipeline. Furthermore, such an assignment is now also
possible for pipe clamps and caps. The corresponding article masks have been adjusted accordingly.

In the image below a flange gasket and a flange connection that appear in the BOM have been assigned to a
pump:

What's new? 235 / 268

News Overview



Expanded HELiOS article masks

The HELiOS article masks for components and parts of the type

n Vessel,

n Pump,

n Other components,

n Cap, round and

n Pipe clamp

have been expanded by the attribute ZUBEHOERSATZ (Accessory set).

Article mask for Vessels
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Article mask for Pumps

Article mask for Other components
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Article mask for Pipe clamps

Article mask for Cap, round
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Change pipeline route

The Change route function has been revised and expanded.

Create connecting guidelines

The Create connecting guidelines function can now be activated via the context menus for pipelines, guidelines or
parts. Right-click them to open the context menu.

Changed context menu

The context menu that can be activated with a right-click after selecting the point to be moved has been changed:

n The creation of connecting guidelines must now be activated in the context menu first (it is now activated by
default).

n The menu items that switch options on or off are now marked with a checkmark symbol. This concerns the
following menu items:

l Snap own points

l Observe maximum lengths

l Create connecting guidelines

l Move connecting parts.

For example, instead of the two menu items Observe maximum lengths and Ignore maximum lengths there is now
only the menu item Observe maximum lengths - either with (activated) or without checkmark (deactivated).
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Change angles

The function now also allows a changing of angles. The connections of the pipeline parts are regarded as possible
rotation axes in the process.

Please note the following:

n If you modify a pipeline with the Change route function and choose a free connecting point as the point to be
moved, angle changes will be possible.

n If you have selected a point within the pipeline, no angle changes will be possible.

As soon as you choose a target point, its connecting direction will be evaluated and the preview will be adjusted
accordingly. A click on the target point ends the route change and the new route will be applied.

The direction at the target point will even be applied if the target point cannot be reached and will remain when you
move the cursor away from the target point again. This allows you to apply a direction from the drawing without hav-
ing to choose a fixed target point.

Due to the new option to change angles, the context menu (right mouse button) has been expanded. This menu
can be activated while HiCAD requests the selection of a target point.
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Option

Do not allow
direction
changes

By default, the connecting direction of Plant Engineering connecting points are used in such a
way that the orientation of the pipeline can be changed. If you choose the Do not allow dir-
ection changes in the context menu, this behaviour will be deactivated.

If the Do not allow direction changes option is active, you will find the Allow direction
changes option in the context menu that restores the default behaviour.

Specify con-
necting dir-
ection

The connecting direction cannot just be changed at Plant Engineering connecting points. The
Specify connecting direction allows you to pick an arbitrary direction in the drawing. You use
the function of a context menu (right-click) for direction specification:

If you specify a connecting direction, this will be indicated by an arrow pointing in the con-
necting direction. This will also deactivate the applying of the connecting direction from Plant
Engineering connecting points, i.e. the specified connecting direction will always be pre-
ferred.

Undo dir-
ection
changes

If you select this option, all directions will be reset to the state of the original pipelines, i.e. all
specified direction changes will be undone.

Select con-
nections
with fixed
angle

Use this option to select connections for which no direction changes should be allowed. The
procedure is the same as the one for selection of fixed points. A single click on a connection
marks the connection, another click removes the marking.
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Close gaps within pipelines

Changed context menu

The context menu for the Close gaps within a pipeline (PE) function has been revised. The menu items that switch
options on or off are now marked with a checkmark symbol. For example, instead of the two menu items Observe
maximum lengths and Ignore maximum lengths there is now only the menu item Observe maximum lengths -
either with (activated) or without checkmark (deactivated).

Variant Editor

Automatic deriving of variants with varying sub-types

You can use the Variant Editor for an automatic deriving of variants. With its help it is possible to create new .VAA
variants whose attributes have been modified via a template in the form of a CSV file. In previous versions the auto-
matic deriving was confined to an adjustment of attributes which are constant throughout all sub-types of a variant.

As of HiCAD 2018 it is also possible to modify sub-types of automatically derived variants. Function call and pro-
cedure are largely identical to that for automatic variant deriving with constant sub-types. However, additional attrib-
utes are available for varying sub-types:

n VAREDIT_CLUSTERING_KEY
A list of columns from the CSV file is assigned to this attribute, which are to be checked for equality.

n VAREDIT_SUBTYPE_KEY
A number of HELiOS attributes which determine the columns to be compared can be assigned to this attribute.
In contrast to VAREDIT_CLUSTERING_KEY, column names of the CSV file are not used here. .
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P+ID

Service Pack 1 2018 (V 2301)

P+ID dialogue types
In the list of dialogue types, the types 510 - 599 are now available as optional item attributes. the do not have a
name, as the name will be defined by the user.

Start P+ID project with new sheets
From now on new P+ID projects will be started with a new sheet. The sheet will be based on the template defined in
the Settings. In addition, you can specify via the Configuration Editor whether the master data dialogue for a sheet
is to be shown when it is created.

Take over changed pipeline diameter in P+ID to 3-D layout plan
You have now the option to change the nominal diameter of a pipeline in the P+ID, even if it pipeline parts have
been subordinated to it by means of a part assignment. When changing the nominal diameter, existing part assign-
ments of subordinated pipeline parts will be adjusted accordingly; this will be indicated by a corresponding mes-
sage. If more that one matching part will be found, one of these part needs to be selected.

When switching to the 3-D layout plan with the Assigned 3-D layout plan function, the assigned pipeline will
be exchanged after confirming the security prompt.

Assign part data

If you want to assign part data to a symbol, select the Edit symbol function and activate the part search. If
pipe class or nominal diameter have been preset, article search will start without any further inputs.
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Major Release 2018 (V 2300)

Apply product structure changes in HELiOS
Changes to article product structures in HELiOS can be taken over by the P+ID.

The steps described below enable you, in the following example, to synchronize comments and update part IDs via

the Update item attributes (P+ID) function.

Step 1: Preparation

If you want any particular P+ID attributes occur multiple times as item attributes in the P+ID symbol mask, these
attributes must be clearly identified in the attrcadhelios.dat according to their position p within the P+ID mask,
namely, with the syntax:

"hicad";"P+ID attribute key(p)";"Designation of item attribute";"TYP";

For instance, the effect of the lines

"hicad";"HICAD_PID_KOMMENTAR(1)";"PID_KOMMENTAR1";"STRING";

"hicad";"HICAD_PID_KOMMENTAR(2)";"PID_KOMMENTAR2";"STRING";

in attrcadhelios.dat will be that the P+ID comment attribute can be declared twice as item attribute.
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To insert the Part ID, add the following line:

"hicad";"HICAD_PID_BAUTEILKENNUNG";"PID_BAUTEILKENNUNG";"STRING";

Then, call the HELiOS for Plant Engineering function in the DBPlantDataImport.exe program.

To be able to modify the P+ID attributes in the attrcadhelios.dat (sys directory) in HELiOS, they need to be entered
into the input masks for item attributes with the help of the Mask Editor maskedt2.exe (see HELiOS).

First, open the Position mask.

After opening the Position mask, right-click on the mask to open a context menu. Choose New data field and enter
the new attributes (Comment(1), Comment(2) and Database Part ID. More information on the Mask Editor can be
found in the HELiOS Online Help

Step 2: P+ID

First, draw a P+ID. Use the Edit symbol function to assign comments and part data to the symbols.
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Create a Main assembly and move the symbols whose assigned articles (=part data) are to belong to their
product structure, beneath the main assembly. Assign an article master to the main assembly. Now you can trans-
fer the product structure for this article (right-click article and choose HELiOS > Transfer structure, one level).

Step 3: Change comment in HELiOS and synchonize with P+ID

Configure the item mask as described in Step 1. In HELiOS, call the article master of the assembly. Click on the

"Plus" icon and activate the Utilized items tab in the mask.

After this, you need to configure the mask. In the Utilized items tab, click on the table header and choose Con-
figure. Activate the table columns Database Part ID (PID_BAUTEILKENNUNG), Comment 1 and Comment 2
(PID_KOMMENTAR1, PID_KOMMENTAR2).

In the Utilized items table you can now change the comment fields.
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By adding the P+ID attribute key HICAD_PID_BAUTEILKENNUNG (HICAD_PID_PART_ID (HELiOS URL) a P+ID
base symbol can be replaced with a regular symbol in the product structure, namely, by replacing the existing
HELiOS URL with the one of the regular symbol.

You obtain the HELiOS URL of a symbol by searching for the corresponding article and choosing the Copy HELiOS
URL function (right-click) in the article master.

Transfer the edits to the article master of the assembly with the Apply item edits function (right-click article master
of main assembly).

After applying the item changes in HELiOS, you can also update them in the P+ID with the Update item attributes

function (in the ICN, right-click the assembly and choose HELiOS).

If text attributes have been assigned to some item attributes, changes in these text points will be instantly visible.

To allow HELiOS a possible replacing of P+ID base symbols with regular symbols, the product structure must be
transferred once more. To do this, click Yes in the message window.
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Transfer the part structure to the HELiOS product structure and close the mask with OK.

Renamed item attributes
The following changes have been made to the IDs for item attributes in order to make the designations more
descriptive:

n HICAD_PID_SACHNUMMER was replaced with HICAD_PID_BAUTEILKENNUNG und

n HICAD_PID_BAUTEILATTRIBUT was replaced with HICAD_PID_DOKUMENTKENNUNG

Further attributes can be found in the list of dialogue types.

Settings from TXTPAR.DAT moved to Configuration Editor
In previous versions the settings for texts and annotations could be set in the TXTPAR.DAT file. As of HiCAD 2018
this file is no longer available. Also, the corresponding setting options at Settings > Basic settings > 2-D have been
removed.

Instead, these settings are now available in the Configuration Editor, namely, at

n Drawing > Annotations > Text > Font and

n System settings > Annotations > Text.

Use the Default parameters function (2-D Dimensioning + Text > Edit (Text) Settings > ...) to load the set-
tings from the Configuration Editor at Drawing > Annotations > Text > Font.

The values of the drop-down lists for font size, text width coefficient and line spacing in the Text Editor and Annota-
tion Editor can be arbitrarily expanded in the Configuration Editor at System settings > Annotations > Text > Pre-
ferred text sizes. After restarting HiCAD the new default settings will be used.
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Viewer

Major Relase 2018 (V 2300)

Display of VAA and PAA files
Like KRA files, the contents of VAA files and PAA files can now be visualized in the Viewer. Only the geometry con-
tained therein will be displayed (General type) and not the individual sub-types. For VAA files he display is limited to
the preview images in the EMF format, and for PAA files to the contained KRA file. If no EMF file exists, or if the
KRA file contains no viewing data no preview can be provided.
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HELiOS Desktop

Service Pack 2 2018 (V 2302)

Combined search: Filter options for Documents or Articles without Links
The behaviour of the Combined search function has been modified: If you deactivate all link classes for the
search, i.e. nothing has been selected in the field beneath Links, all objects matching the entered search criteria
that are not linked to any other object will be shown in the corresponding result list.

In this way you can, for instance, list documents of already deleted articles in conjunction with other, attribute-
related search criteria, e.g. in order to link, move or delete them.

Furthermore, you can search for articles without assigned drawing in order to determine for large assemblies
whether drawings have been created for all related parts, or whether parts have been "overlooked" by mistake.
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Result list settings for Combined search
Beneath Object-specific on the Result lists tab of the HELiOS Options dialogue window you can find a new pull-
down menu item called Document and Article.

This setting is for the Combined search function. It allows you, for instance, to display the result lists of a combined
search sorted by document numbers in ascending order by default.
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Enhanced model structure representation
The Model structure representation in Document detail masks has been enhanced.

Icons in the tree structure indicate the model type (part, assembly...) and dependent parts are also marked as
such.

Also, it is indicated for each Inventor-related item whether it is a "regular" Part / Assembly, a parameter reference or
a third party reference.

Multiple occurrences of items are indicated in the Qty. column.

Please note:

To ensure a correct result list representation of the model structure, the Article context of the top part must be
unambiguous!

The Article context of the sub-parts is determined by the saving in the CAD system.
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Result lists: Marking of new indices
In the result list configuration you can find the new Index up-to-dateness attribute ("UI_DocumentNewerIndex" for
documents, "UI_ArticleNewerIndex"for articles):

If an Article or a Document has a newer index, older indices will be indicated in the Index up-to-dateness column
with a star symbol:

Right-clicking the title of the Index up-to-dateness opens a context menu. The menu item Strategy allows you to
choose between three different additional display options:

n Newer index: The symbol indicates that a newer index exists for the listed object, i.e. that the index of the
listed object is not up to date.

n Newer index (detailed):If the object is marked with the symbol, a higher (newer) index exists, but no newer

released version of the object. The symbol indicates that higher and released indices exist for the listed

object, but that the highest index has not been released yet. If a result list entry is marked with the symbol,
this indicates that a version with a higher index with Workflow status "Released" exists.

n Newer released index: If a result list entry in the Index up-to-dateness column is marked with the symbol,
this indicates that a higher index with Workflow status "Released" exists.

A simple click on the star in the result list opens the Version Management for the corresponding object, a double-
click will additionally open the Document / Article detail mask.
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Whether only current or all indices are to be displayed in the result lists can be specified in the HELiOS
Options at Result lists > Show objects.

Items combined into sets: Enhanced context menu
For the editing of items that have been combined into sets you can find an extended context menu that does not
only consider the combined set of items, but also offers the option to edit the individual items.

For instance, you can delete items from the product structure, or remove the CAD link if desired.

Detail dialogues in Windows task bar
Detail dialogue windows of HELiOS are shown as minimized windows in the Windows task bar.

Each of the different object types (Article, Document, Project, Folder, User-defined type) is represented by a cor-
responding icon. In the text line next to the icon the name of the object is shown (e.g. the document number).

If an object from the result list of a Folder Explorer or Project Explorer has been opened, the Folder context or Pro-
ject context, respectively, will also be shown, accordingly.

Also, older indices of the corresponding object will also be indicated.

254 / 268 What's new?

HELiOS Desktop



What's new? 255 / 268

News Overview



Service Pack 1 2018 (V 2301)

Performance
A performance increase of 20 - 30 % could be achieved for the loading and build up of mask elements.

Product structure: Switch item

The context menu for items now contains the new Switch item function.

Use this function to switch an article of an item for another item.

When you call the function the Find article dialogue window will be displayed. Here, choose the required article (a
search for a concrete index is also possible here). Confirm to exchange the article.

Please note that the function considers the settings for the Database option Allow updating of released product
structures.

Attribute configuration for Model items
The Edit attribute configuration dialogue window for result list configuration on the Model structure context of
Documents now offers the additional Model item tab with model item attributes.
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New date selection
The dialogue for data selection, e.g. for the finding or the input of objects, the selection of a particular index date in
the result list display etc. comes with a new Look & Feel.

This also includes a menu with extended selection options for a date-based search for objects (e.g. documents, art-
icles, folders).

You can also search for objects here that have been created at a particular data and time, or select multiple spe-
cific dates.

Furthermore, you can limit your object search to specific creation, index or checking dates or periods.
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Result list button for opening of documents
As a faster alternative to a function selection via context menu (right-click and choose function), you have now the
option to assign buttons to document result lists, allowing you to open documents in the linked application with one
mouse click, either for editing or in read- only mode.

For this purpose the two attributes UI_OpenEditItem and UI_OpenItemReadOnly have been created, which just
need to be activated in the result list configuration.

AS of Service Pack 1 these buttons are available in every result list with document context, e.g. in the Document
Class Explorer, in the HELiOS Workspace, in the Targets tab of article master masks etc.
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Major Release 2018 (V 2300)

Editing of combined items
The attributes of combined items on the Utilized items tab can now be edited in one step if the values of the item
attributes are identical.

If this is not the case, the concerned attribute value cannot be edited on the basis of the combined items. For the
corresponding combined item the entry "Different values" will be shown in the Comment column. In such cases the
items must be edited individually.
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New attribute mapping configuration for document input via Drag & Drop
As for the serial document input in Version 2017 SP2, the attribute mapping is now also controlled via new con-
figuration files for document input via Drag & Drop, i.e. you have the option to individually expand the configuration
options for attribute mapping.

When you enter a new document via Drag & Drop, you will now find an additional pull-down menu for attribute map-
ping configuration at the bottom left of the displayed Enter document dialogue window:

If different configuration files have been stored in the system, these will be offered in this pull-down menu. Other-
wise, only the Standard configuration will be available for selection.

In this way you can assign recurring initialization patterns with only a few mouse clicks, instead of having to set
them manually every time.

Please note:

This new procedure replaces the previous configuration file hel_fileattributes.ini. This means that utilized mapping
configurations may be renewed since the data from hel_fileattributes.ini will not be used any more.
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HELiOS in HiCAD

Service Pack 2 2018 (V 2302) 

Semi-finished Product Article as Sub-item
Semi-finished products can be automatically transferred as sub-items of a part to HELiOS.

This can be set in the Configuration Editor at Active configuration > Base configuration > PDM > HiCAD-HELiOS
interface > Product structure. Here, activate the Semi-finisherd product article as sub-item checkbox.

If a HiCAD model drawing (.SZA document) or an individual geometry (.KRA document) is saved in HELiOS while
the option has been activated, it will be checked whether a semi-finished product needs to be saved as s structure
sub-item of the corresponding part (=HELiOS article).

The relevant semi-finished product article masters will then be added as sub-item, or updated accordingly in the
product structure of the part.

Service Pack 1 2018 (V 2301) 

Performance
A performance increase of 10 - 20% could be achieved for product structure transfers from HiCAD to HELiOS,
which may involve very large amounts of data.
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HELiOS Spooler

Service Pack 2 2018 (V 2302)

DSTV-NC-Export
When converting files via the HELiOS Spooler you can now also choose the DSTV-NC format. The format-specific
export options that were last specified and saved in HiCAD will be used in the process.
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Service Pack 1 2018 (V 2301)

New module structure
The module structure of the HELiOS Print and Plot Management has changed. The following three license mod-
ules are available:

n HiCAD Spooler

n HELiOS Spooler

n HELiOS Spooler Client
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HELiOS MS Office Interface

Service Pack 2 2018 (V 2302)

Project and folder data input
The HELiOS Ribbon tab for Office applications has been further enhanced with functions for the input of new pro-
jects and folders.

This allows you to create new projects or folders directly in your Office application (e.g. in Word) and assign the
Office documents to them, which spares you the additional step via the HELiOS Desktop.

264 / 268 What's new?

HELiOS MS Office Interface



Major Release 2018 (V 2300)

New HELiOS Workspace
All file-based MS Office interfaces (Excel, Word, PowerPoint) now share a common HELiOS Workspace, as is
already known from the HELiOS -MultiCAD interfaces.

The Workspace provides a clear overview of the locally checked-out files at any time, as well as a direct check-in or
cancelling of the corresponding file edits.

Furthermore, you have access to all HELiOS functions for the listed documents in the Workspace via a context
menu (right-click document).

Depending on your preferred working method, you can decide whether you want HELiOS to generate unique file
names, or if you want to assign file names manually.
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Open documents for editing or in read-only mode
In the HELiOS Ribbon tab of your Office application you can choose between two opening modes for documents: If
you select Open+Edit, the Office document will be loaded from the HELiOS database, and can then be edited; if
you select Open, read-only, the loaded Office document can only be viewed, but not edited.
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